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Thank you very much for choosing HDClone. It is our expressed goal to offer a
product, that fully meets your requirements and expectations. In case of having
suggestions or not being satisfied with the software, we kindly ask you send your
suggestions and criticism to feedback@miray.de.

1 Introduction: Offers general information about this manual and the program.
Particularly, it contains an overview of the available editions and their abilities.

2 Fields of application: By supporting physical copies, HDClone is suitable for
many different areas of application. Here you find descriptions and hints for the
most common areas of application of the program.

3 Supported hardware: In this chapter, you find a list of supported controllers
and media as well as information about which aspects to consider when using
certain types of controllers or media.

4 Installation: For using HDClone, you can install it as a normal Windows program
and/or create a bootable medium This chapter describes how this can be done
within few minutes, using the installation package.

5 Program instructions: This chapter contains the actual manual for operating
HDClone. It is a step-by-step description of how to operate the program for cre-
ating a copy with HDClone.

6 Operating principles: Here you find useful descriptions and hints for gaining
optimal performance when using HDClone with different types of media as
each media type can have its very own characteristics.

7 Troubleshooting: In case you encounter any problems when using HDClone,
you find detailed descriptions and support here. By means of these information
you will be able to solve or bypass occurring problems in most cases.

8 Miray Virtual Disk: The HDClone software package includes the Miray Virtual
Disk application. With this software you can mount file images as virtual drives.

9 Miscellaneous: In the last chapter you find miscellaneous information, particu-
larly regarding our support and HDClone licensing terms.



In this manual, keys on the keyboard are printed with a gray background, for ex-
ample Esc for the escape key or = Return for the return key. Some keys are
represented by a corresponding symbol, e.g.  t for the 'up-key. Visual controls
on the screen, particularly buttons are represented by brackets ([ and 1) and
semi-bold type, e.g. [next], [back].

HDClone lets you make physical and logical 1:1 copies (clones) as well as physi-
cal and logical file images of hard disks and partitions. Physical 1:1 copies ensure,
that the copy is sector-by-sector 100% identical with the source. This allows
HDClone to create copies or file images of hard disks regardless of the respec-
tive partitioning scheme, the used file system and the installed operating
system(s). Thus HDClone is especially suitable for the tasks described in » 2
Fields of application as well as for many other tasks.

The physical copying process of HDClone for exact (bit-wise) 1:1
copies and 1:1 images makes it suitable for many areas of application.
HDClone’s features make it a valuable tool, even in special and extraor-
dinary scenarios.

There are different editions of HDClone. They differ from each other by the
amount of features they offer, particularly supported device types, performance
and special options. The following table offers you a comparative overview of
the editions and their features. Subsequent, there are short explanations refer-
ring to some of the topics listed in the table.

Within the table the following abbreviations are used to identify
the different editions: = Free | = Basic | = Standard |
= Professional | EE = Enterprise

Device support
IDE/ATA/SATA hard disks
AHCI (SATA 1)

USB (UHCI, OHCI, EHCI)
Hard disks > 2048 GB (2 TB)

O e e e
e o o o
e o o o
e o o o
e o o o
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FE BE SE PE EE
USB 3.0 (XHCI) o ° °
Firewire / IEEE1394 (OHCI) o o .
SCSI hard disks =’ o ) o . .
Copy modes *
Drive copy . ° ° ) .
Partition copy o . ° ° .
SmartCopy o o ° ) .
PartitionSelect o ) ° . .
MultiCopy (4x, 8x, 16x) o o o o .
File images
Physical images ° . . ° °
Logical images (Smartimage) o o . ° °
Compressed images o o ) ° °
Password protected images o o) . . °
Securely encrypted images o o o ° °
QuickCompress, StrongCompress o o o ° .
RAW images o o o ° .
Dynamic VMDK & VHD images o o o . °
Special modes °’
HotCopy . ° ° ° .
Up-sizing (NTFS, FAT, ext2-ext4) . ° ) ° .
Down-sizing (NTFS, FAT) o . . ° °
Livelmage o ° ° ) .
SafeRescue mode o ° ° . .
Defragmentation (NTFS, FAT) o o ° . °
Verification mode o o ° ° °
Advanced Format / 4K conversion o o o ° °
Command line interface o o ) ° °
FastCopy mode o o o . °
Storing a clone report o ) ) ° °
Copying speed
Maximum speed in MB per sec. | 30 | 50 | 60 100+ [1000+
Miray Virtual Disk
Virtual volumes o 1 1 7 7
File image management o 1 1 ° .
Persistent virtual disks o o o ° °
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FE BE SE PE EE

Virtual volumes @ TrueSpeed " o o o .
Mounting VMDK & VHD images o o o .
License scope °

Private use ° . ) °
Professionals/corporations o o ° °
Technician license o o o °

N

w

IS

e}

o

S~

®

SATA hard disks: Have to be connected to a SATA controller supported by HDClone and

the controller has to be configured correspondingly ( » 3.3.2 SATA/SATA-II controllers).

Hard disks > 2048 GB: HDClone supports hard disks above 2048 GB (2 Terabytes) from

the Professional Edition on.

SCSI hard disks: Have to be connected to one of the SCSI host adapters supported by

HDClone ( » 3.4 SCSI).

Copying modes: You find further information regarding the different modes in chapter » 6

Operating principles.

« Drive copy: Allows to make a copy of entire drives.

« Partition copy: Allows to make a copy of single partitions.

» SmartCopy: Creates a logical 1:1 copy. usually faster by a multiple ( » 6.1.2 SmartCo-
[9%2

* MultiCopy: Mass-copying to up to 4/8/16 targets at a time, multiplying transfer ratio ac-
cording to the Enterprise Edition used (4x/8x/16x) (» 6.5 MultiCopy).

Special modes: Increased copying speed (FastCopy), data integrity and safety (verifica-

tion, SafeRescue), use within Windows at runtime (HotCopy, Livelmage). Further informa-

tion to be found in chapter » 5.8 Selecting the options.

Copying speed: Due to technical differences between the individual editions, there is an

upper limit for the actually achievable copy speed of each edition.

> 100 MB/sec: Up to 133 MB/sec. using Ultra-DMA 6, up to 300 MB/sec. using SATA II.

> 1000 MB/sec: Mass-copying to up to 16 targets at a time.

Virtual volumes @ TrueSpeed: Use of RAW images at almost hardware speed.

License scope: See also chapter » 9.1 Terms of license.
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2 Fields of application

HDClone is specialized on creating physical copies. Therefore HDClone offers
particular advantages for copying resp. rescuing defective media ( » 2.2 Data
rescue). In addition, HDClone is able to work independent from partitioning
scheme, file system and operating system. This allows to copy entire operating
system installations ( » 2.1 Upgrading hard disks & migrating an OS) or to be able
to create an exact copy in case of unknown/proprietary file systems ( » 2.6 Pro-
prietary hard disk formats). Altogether, HDClone covers a wide spectrum of pos-
sible applications by its universal copying technology. In the following you find
descriptions of the most common areas of application of HDClone. The individ-
ual chapters contain instructions as well as further advice regarding accomplish-
ment of the respective application.

Hint: HDClone allows you to copy data arbitrarily between all types of
@ media recognized, particularly between different types of drives.
<

2.1 Upgrading hard disks & migrating an OS

Since HDClone works independent of file system formats and operating systems,
you can use it to migrate entire installations, including the installed operating sys-
tem, to another hard disk. This is especially useful if you want to migrate an exist-
ing installation to a new hard disk without having to install the operating system
and applications again. For this type of application, the » 6.1.3 Drive-to-drive
mode is most suitable. Use the PartitionSelect feature ( » 6.6 PartitionSelect) to
choose individual partitions to be cloned.

o Note: Please take care to have only one hard disk connected after
completing the copy and before starting the operating system. It should
be plugged to the same channel as the original. Hence, either remove

the copy or connect it instead of the original medium.

2.1.1 Unused disk space

Free disk space on the target medium can be converted into a partition and
used as an additional drive from within Windows by using the fdisk tool or the
Windows Computer Management (C:\WINDOWS\system32\compmgmt.msc).



In general, you can also copy from a larger to a smaller medium. For NTFS and FAT
file systems, HDClone can perform downsizing automatically. For other file sys-
tems, you may downsize the partitions on the source medium before cloning, us-
ing appropriate third-party tools before cloning.

In case of hard disks with defective areas it is especially important, that they are
being rescued to an intact medium before starting any recovery attempts. Oth-
erwise, depending on the kind of defect, the recovery procedure may cause
further defects resulting from the inherent exposure of this procedure. Of course,
using HDClone also cases exposure for the hard disk. But the physical copying
causes much less exposure than any other usage due to its linear operation, i.e.
only continuous movement of the disk's heads. Furthermore, the option SafeR-
escue (» 5.8.8 Advanced options) is able to reduce exposure to an absolute
minimum. In very critical cases, you can also just copy single partitions to reduce
exposure for the medium even more ( » 6.1.4 Partition-to-partition). After hav-
ing rescued the data from the defective hard disk, you can perform a recovery
on the (functional) target medium without having to fear any further damages.

Only a physical copy allows to rescue all of the data (except ir-
recoverable areas), even if there are logical errors resulting from defec-
tive areas. For this reason, use SmartCopy mode ( » 6.1.2 Smart-
Copy) for rescuing data.

Alternatively, you may create a RAW image or a physical image.
You then can restore the image to another hard disk later or perform
the recovery directly on the image by mounting it as a virtual drive us-
ing Miray Virtual Disk ( » 8 Miray Virtual Disk).

HDClone can also create a local backup of an entire system installation. If re-
quired, a simple restore from the backup partition brings the system installation
back into its original state - without any dead freight, faulty program installations,
viruses etc. For this purpose, create an unused partition in addition to the system
partition of at least the same size to serve as a backup partition. Then create a file
image and restore the original system from that image when needed.

Before restoring from the backup partition, save your work files
and other data from the system partition or store them somewhere
else, since they otherwise will be overwritten.



HDClone Enterprise Edition is specially designed for creating up to 16 copies at a
time. This makes it especially suitable for industrial duplication of pre-installed
software (e.g. on hard disks or on CompactFlash media etc.) or for creating sev-
eral identical operating system installations ( » 2.5 Master installations)

HDClone is also suitable for duplicating (deployment) system installations ( » 2.4
Mass copying). Copy an entire master hard disk or master partition to the target
medium to create a complete installation there and to have it ready for action.

When duplicating Windows XP, we recommend to run sysprep
(included in Windows) before cloning. Further information is to be
found at Microsoft at http://www.microsoft.com, search for ,sysprep’.

HDClone is capable of copying arbitrary hard disk formats. Especially for hard
disks installed in proprietary systems (e.g. studio technology, medical technology
etc.) there are often no programs besides system software, which can read the
data on these media. HDClone can rescue this data or moving it to a new
medium without any problem. The best way is to copy the original medium to a
target medium of the same or larger size. A target medium smaller than the
original medium should not be used, as it cannot be assured, that all relevant
user data will be transferred in this case.

In case of unknown or proprietary (non-standardized) formats,
always copy the entire original medium. You should only use the mode
» 6.1.4 Partition-to-partition if you know for sure that the partitions are
reported correctly.

HDClone is also very suitable for safekeeping data for forensic purposes, as re-
ally all data from a hard disk is copied, including data, that has possibly been hid-
den or deleted. This data cannot be reached any more via the usual file system
mechanisms. Therefore it will be useful to create a copy in drive-to-drive mode
(» 6.1.3 Drive-to-drive) or a RAW image (» 6.2 Size differences) before per-
forming a detailed forensic analysis of secured media. This allows you to make
changes to the copy during analysis without altering and thus endangering the
original content of the medium.



When backing up data for forensic safekeeping, hidden and de-
leted files can be located anywhere on the medium, it is always re-
quired to create a copy of the entire medium to a target medium of the
same or larger size. use SmartCopy mode ( » 6.1.2 SmartCopy)
for this type of application.

In HDClone, working with physical and logical images follows the same basic
logic as physical and logical copies, which are performed directly from medium
to medium. File images offer the following advantages:

o Simple storing and managing in your file system

o Optional compression for minimum space required

o Password protection and AES encryption to protect data

o Distributing without physical media via networks and the Internet
o Accessing individual files via virtual drives ( » 8 Miray Virtual Disk)

o Use with virtual machines ( » 6.7.4 Dynamic VMDK and VHD images)

To rescue a defective hard disk, you may create a physical (!)
image ( » 6.1.3 Drive-to-drive) instead of a physical 1:1 copy ( » 6.2 Size
differences). In both cases, a bit-wise identical clone of the master hard
disk will be created.

HDClone supports creating clones or images of a Windows drive while Windows
is working - even of the Windows system partition itself. To use this feature, it is
not necessary to take certain steps. When using HDClone/W, the appropriate
mechanisms for using HotCopy and Livelmage will be activated automatically.



ﬂ Overview 17
3 Supported hardware

This section contains detailed information about the hardware and hardware
standards supported by HDClone. Furthermore, there are special references to
be found regarding the usage of certain device types.

3.1 Overview

Subsequent, you find a listing of the hardware requirements concerning the
hardware used to run HDClone as well as additionally supported devices.

o Note: The devices listed below represents the entire spectrum of hard-
Tl | ware supported by HDClone. Which of them can be used with a cer-

tain edition is listed in » 1.4 Edition overview.

3.1.1 Hardware requirements

o PC 80586 or higher, 500 MHz, 128 MB RAM, VGA (optimal: VESA support)
o Keyboard & mouse: PS/2 or USB

o Bootable floppy or CD drive or bootable USB medium

3.1.2 Supported media

Under Windows (HDClone/W):
any mass storage media supported by Windows

DE/ATA hard disks, CompactFlash via IDE "
SATA hard disks (internal & external)

[e)

o]

(0]

o]

SCSI hard disks (internal & external)

(o]

USB hard disks (internal & external)

o}

Firewire hard disks (internal & external)
USB keys ?, CompactFlash | ¥, CompactFlash Il ¥, MicroDrive *, SD/MMC *
xD-Picture Card *, Memory Stick *, Memory Stick PRO *, Memory Stick DUO */

(o]

(o)

CompactFlash media with TruelDE support
Must support the USB-Mass-Storage-Class protocol
Via an appropriate USB card reader

N

w



o any controller supported by Windows
o PCI-IDE controller and Bus Master IDE controller

o PCI-SCSI host adapter ( » 3.4.2 Compatibility)

o SATA controller with IDE interface ( » 3.3.2 SATA/SATA-II controllers)

o SATA-II controller with AHCI interface ( » 3.3.2 SATA/SATA-II controllers)
o USB UHCI & OHCI controller (USB 1.1)

o USB EHCI controller (USB 2.0)

o USB XHCI controller (USB 3.0)

o |EEE1394 OHCI controller (Firewire)

HDClone has been developed for the hardware listed in » 3.1 Overview and
tested on a large number of devices. HDClone also works well with many other
devices. Please use the HDClone Free Edition to easily check out in advance and
for free whether the device in question is supported ( » 3.2.1 Compatibility test).

You can use the Free Edition of HDClone to find out easily if your hard disks,
other media as well as the associated controllers are supported properly, even if
a higher edition is required to use them with HDClone. For this purpose, simply
start HDClone Free Edition on the respective PC, chose a drive-to-drive copy
and click on [Next]. All drives displayed there as well as the associated control-
lers have been recognized by HDClone and are supported by one of the avail-
able editions. Which edition will be necessary to utilize a certain device type can
be seen from the info box at the right side of the list box when you select the
regarding drive ( » 5.7.4 Drive information).

Please ensure that you connect the needed USB devices before
starting the program to ensure that they are recognized correctly ( » 5.1
Preliminary steps).

To be able to support as many devices as possible, HDClone implements the ef-
fective standards for the appropriate device types. Device support in HDClone
primarily refers to the standards applicable to the appropriate device type. In



addition, we perform extensive tests with each device type. Those test also re-
veal that there is @ number of devices, which themselves implement their re-
spective standard only insufficiently or even inaccurately. Furthermore, it is pos-
sible that some problems occur in certain hardware configurations, usually in
certain combinations of controller and device. If possible, HDClone tries to sup-
port even such devices and to bypass the any hardware deficiencies. However,
these kinds of problems can not always be bypassed. Hence even extensive
tests cannot completely prevent that a problem appears in your special hard-
ware configuration. In most cases this can be solved by setting the options ap-
propriately ( » 5.8 Selecting the options and » 7 Troubleshooting). In case of
even this does not work, our support team ( » 9.5 Support) will be there to assist
you with solving the problem.

Generally, HDClone supports IDE/ATA/SATA hard disks. A necessary precondition
is to have them connected to one of the IDE/ATA/SATA controllers supported by
HDClone ( » 3.3.1 IDE/ATA controllers and » 3.3.2 SATA/SATA-II controllers).

HDClone supports standard IDE controller (ISA) and PCI IDE controller. These
may be (internal) onboard controllers as well as (external) PCI/ISA adapter
cards. In case of ISA/Standard IDE controllers, the first two channels are scanned
for hard disks. HDClone recognizes available PCI IDE controllers automatically
and scans them for connected hard disks.

If there are one or more PCI IDE controllers available in the sys-
tem, ISA controllers that are possibly present, too, will not be taken into
account and drives connected to them will not be listed.

HDClone supporting PCl IDE controllers refers to a standardized programming
interface, which is supported by a large majority of IDE controllers. See » 3.2.1
Compatibility test about how to check if your PCI controller complies with PCI
IDE standard.

Precondition for the support of SATA drives is an SATA controller with IDE inter-
face or an SATA Il controller with AHCI interface. All popular chipsets from Intel
with ICH-5/-6/-7 incorporate such an IDE-compatible SATA controller. Regretta-
bly, many other SATA controllers only offer a proprietary programming interface.
Nevertheless, it may be possible in case of onboard SATA controllers to activate



a compatibility mode in BIOS setup, which would allow HDClone to access the
SATA controller. As for SATA Il controllers, many models already implement the
AHClI interface supported by HDClone.

With HDClone Free Edition you can easily check out if your SATA
or SATA-II controller is supported ( » 3.2.1 Compatibility test). Connect
at least one SATA drive and start HDClone. If the SATA drive is recog-
nized, HDClone also supports the associated SATA/SATA-II controller.

It might be necessary to adjust the SATA settings in BIOS. As mode
of operation, IDE, ATA, compatible or AHCI should be chosen, but in no
case RAID or SATA. Additionally it may be necessary to set the control-
ler configuration to combined, especially for allowing simultaneous use
of IDE and SATA hard disks. In this case there are only ports O and 2 or
1 and 3 available for SATA. Please connect the SATA hard disks corre-
spondingly in this case.

HDClone automatically recognizes and uses bus master IDE controllers, which al-
low data rates up to 133 MB/sec resp. 7.8 GB/min. Hereby, Multiword DMA (up to
16.7 MB/sec) as well as Ultra-DMA (UDMA) are supported. This can increase
achievable data transmission rates by a multiple higher of the rates that can be
achieved without DMA (in PIO mode). HDClone recognizes automatically wheth-
er controller and hard disk support DMA and then automatically selects the fastest
usable mode (Multiword DMA or Ultra-DMA 33/66/100/133).

Please take into account that both, hard disk and IDE controller
have to support a certain DMA mode. If the actual speed does not
match the technical data of a hard disk, the reason may be that the IDE
controller only supports lower modes. Furthermore, the achievable val-
ues also depend on the physical abilities of the hard disk, i.e. a hard disk
with UDMA-6 (theoretically 133 MB/sec.) currently achieves an actual
transfer rate of about 90 MB/sec.

Precondition for using DMA mode is that the attached PCI IDE controller also sup-
ports the Bus master IDE standard. Whether your PCI IDE controller supports Bus
master IDE can be determined by means of the program PCISniffer, which can be
downloaded for free at http.//www.miray.de/download/sat.pcisniffer.html. The
field .Classcode’ in PCISniffer has to contain the value 01018x (x = arbitrary) for
the respective PCI IDE controller.




For using Bus master IDE, the settings and initializations made in
and by the PC’s system BIOS play a major role. In case of problems with
utilizing DMA, it is likely that certain BIOS settings have to be accommo-
dated correspondingly ( » 7.4.3 Problems with DMA).

The speed DMA can achieve always depends on the physical abilities of a hard
disk. The rough classification below shows the approximate speed to be expect-
ed from a certain drive type:

Type Age Speed

Older drives About 5-10 years About 5-30 MB/sec

Newer drives About 2-5 years About 30-60 MB/sec.

Top models About 0-2 years About 60-120 MB/sec and more
SSDs About 0-2 years About 90-200 MB/sec and more

If your edition of HDClone supports SCSI hard disks, the following chapters pro-
vide important information on utilizing and compatibility of SCSI devices.

Since HDClone embeds original driver code of the hardware
manufacturers, there no influence on actual compatibility. The follow-
ing information is based on specifications of the manufacturer.

You can use HDClone with SCSI hard disk in the same way as with any other me-
dia. HDClone automatically recognizes supported SCSI controllers and connect-
ed SCSI hard disks at program start and displays them, along with other recog-
nized media, in the respective selection lists.

You can copy data from SCSI hard disks to other media types ( » 2
Fields of application). This is important for the purpose of data rescue or
if there is no SCSI target medium at hand, as any arbitrary medium can
be used for (temporarily) storing the regarding data.

Generally, HDClone supports SCSI hard disk drives. As a precondition, they have
to be connected to a SCSI controller HDClone supports. Currently, HDClone
supports Narrow-, Wide-, Ultra- and Ultra-Wide-SCSI controllers from Adaptec.



Use the Free Edition to determine whether your SCSI controller is
supported ( » 3.2.1 Compatibility test). If HDClone recognizes the SCSI
drive, HDClone will also support the SCSI controller.

The drivers integrated in HDClone support the following SCSI adapters:

AHA-2930U AHA-2940 Ultra ~ AHA-2940UW AHA-2940AU
AHA-2944UW ASC-19160 ASC-29160 ASC-29160LP
ASC-29160N ASC-39160

HDClone supports even more controllers, either as onboard chipset (AIC) or as
addon card (AHA, ASC). They are determinable by their respective vendor and
device IDs which are listed in the following table.

Vendor Model Device Vendor Model Device
9004h AHA-2930U 3860h : AHA-4944UW 8678h
’ AHA-2930CVAR 3868h ’ AIC-7887 8778h
’ 3869h ’ AIC-7888 8878h
AHA-4944(U)W 3B78h : AHA-4944(U)W EC78h
AIC-755x% 5x75h 9005h | AHA-2940/50U2W | 0010h

AIC-785x% 5x78h ’ AIC-789x 001xh

AIC-7560 6075h " 002xh

AIC-786x 6x78h " 003xh

AIC-7870 7078h ’ AHA-3940/50U2x | 0050h
AHA-2940(W) 7178h " AHA-3950 U2x 0051h
AHA-3940(W) 7278h : AIC-7896/7 U2 005Fh
AHA-2944 7478h " AIC-789x 006xh
AHA-3944(W) 7578h ! " 007xh
AHA-4944(U)W 7678h : AIC-7892(A|B)U160 | 008xh
AIC-7877 7778h ? AIC-789x 009xh

AIC-7860 7860h ’ Y 00Axh

AIC-7895 7895h " " 00Bxh

AIC-7880 8078h . AIC-7899(A) U160 | 00Cxh
AHA-2940U(W) 8178h : AIC-789x 00Dxh
AHA-3940U(W)(D) | 8278h ? . 00Exh
AHA-2944UW 8478h " 00Fxh
AHA-3944U(WD) 8578h " AHA-2930U2 0180h

The IDs of your controller can be determined by PCISniffer. It can be download-
ed for free at http://www.miray.de/download/sat.pcisniffer.html. For the SCSI
controller in question, the values displayed by PClSniffer for the fields Vendor ID
and Device ID have to match the values specified above for your SCSI controller.




The following chapters contain information regarding utilization and compatibil-
ity of USB storage media and controllers.

Please take care to connect USB devices already before starting
HDClone ( » 5.1 Preliminary steps) and if possible directly to the PC or
to the USB controller addon card ( » 3.5.4 Hubs).

USB storage media to be used with HDClone has to support the USB-Mass-Stor-
age-Class protocol, an official standard supported by almost all current USB
sticks, card readers, hard disks etc. If you are not sure if a certain USB storage
medium is supported, proof it using the Free Edition ( » 3.2.1 Compatibility test).

In case of USB devices, it is crucial that HDClone supports the USB controller
used. HDClone is capable of all three common USB standards, UHCI and OHCI
for USB 1.0/1.1, EHCI for USB 2.0 as well as XHCI for USB 3.0. In the area of stan-
dard PCs, all current USB controllers, onboard controllers as well as adapter
cards, offer one of these three interface standards. In case you are not sure
though, you can use HDClone Free Edition to check ( » 3.2.1 Compatibility test).

HDClone also supports the new XHCI standard. Therefore it is able to use fast,
USB 3.0 SuperSpeed technology mass storage media of the latest generation.

USB devices are sometimes connected via a USB hub. For achieving the highest
possible transfer rate, you should connect USB disks directly to the PC's USB port.

If your edition of HDClone supports Firewire, you can connect arbitrary Firewire
drives or card readers. Connected devices must support the Serial-Bus-Protocol
(SBP) in order to be recognized and operated correctly by HDClone.

Please take care to connect Firewire devices already before start-
ing HDClone ( » 5.1 Preliminary steps) and if possible directly to the PC
or to the Firewire controller.
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4 |nstallation

4.1 Introduction

HDClone can be started without an installation directly in Windows or without
the presence of an operating system as a self-booting application from CD, flop-
py disk or USB key ( » 4.1.1 Bootable medium). Additionally, there is a setup pro-
gram for installing HDClone in Windows ( » 4.2.1 HDClone Setup).

4.1.1 Bootable medium

In case you have HDClone already available on a bootable medium, you can
start and use the program immediately on any PC and without any preceding
installation, as described in chapter » 5.2 Starting the program.

Note: It is possible that, although you have HDClone on a physical me-
dium, it may not be in form of a bootable medium but rather as an in-
stallation package. Create a bootable medium at first, according to the
following description ( » 4.1.2 Software package).

4.1.2 Software package

As far as you do not receive HDClone on a bootable medium, you can create
one by yourself. The software package contains the required files. The following
chapters describe how to create a bootable medium. It then can be used to start
HDClone on any PC without any further installation ( » 5.2 Starting the program).

4.1.3 Miray Virtual Disk

Some editions of HDClone also contain | @ e ot seue
the software » 8 Miray Virtual Disk an p
application to mount file images as vir-
tual Windows drives. Miray Virtual Disk

 Miray HDClone you wank o install

Check the camponents you want o install and uncheck the campanents you dorit want to
instal. Cick Next to cantinue,

will be installed automatically during || s | e

(7] Start Meru
HDClone setup. In case you do not Eomtmmstanas
want to have it installed, please dese- sy s o
lect it in the first installation screen B
(»fig. 1).

fig. 1: HDClone setup start screen



The HDClone software package contains a setup program (setup.exe), allowing
you to install HDClone directly on Windows into a program folder. This will - by
choice of the user - also create an Start menu folder as well as links on your
desktop and in the Quickstart bar ( » 4.2.1 HDClone Setup).

The HDClone software package also contains an installation program for creat-
ing a bootable floppy disk or CD/DVD with only few mouse clicks ( » 4.2.2 Boot-
Setup & boot media). To use the boot setup program, please run setup.exe first.
Then start [All Programs] » [HDClone] » [Create bootable medium] in the Win-
dows Start menu.

Alternatively, in case you have a software package in the ZIP file
format, you may extract all files to an empty folder. Then execute the
file setup.exe from there.

Start setup.exe ( » fig. 1) and select the desired options on the first screen. Then
follow the instructions displayed to install HDClone on your Windows PC. After
setup has finished, you are asked in the final screen to choose whether to start
HDClone directly.

HDClone Setup also will install the software Miray Virtual Disk, as
far as you did not deselect it on the first screen. This will also include a
software driver to be installed. For this reason, a Windows dialog win-
dow regarding driver installation ( » fig. 2) may appear during setup.
Confirm it with [Continue Anyway]. In case Windows will display the
Found New Hardware Wizard ( » fig. 3), close it with [Cancell.

Hardware Installation

v} The saftware pau are instaling far this hardware:
.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Miray Virtual Disk Adapter

Windows wil search for cument and updated software by

has nat passed Windaws Logo testing ta verlly its carmpatibilty

with Windows 3P [Tell me why this testing is important. )

Continuing your installation of this software may impair
or destabilize the correct aperation of your system
cither immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

O Yes. this time only
© Yes,now and every ime | camect 2 device
© No. riot this time

Ciick Neat to corntinue,

[ Eontinus Anyway | [ STOP Installation

fig. 2: Hardware Installation dialog fig. 3: Hardware Wizard dialog



If you received HDClone on a physical medium, you may addition-
ally use setup.exe to install HDClone on Windows. A software package in
the ZIP file format has to be un-zipped first. In case you have download-
ed the setup.exe file (selfextracting), please start it directly.

When starting the Boot-Setup program, [ Hocione gost setun =)
the main window appears ( » fig. 4).

o If you want to create a bootable
floppy, choose the drive at Floppy
drive and click on [Create floppy].

o For a bootable CD/DVD, select the (R
desired drive under CD/DVD writer
and click on [Create CD/DVD].

Status
Select a destination drive below.

o To create a bootable USB key, Flappy diive
reate floppy image files - Cireate floj
choose the desired drive at USB me- [Cesteopey mee K
dium and click on [Make bootable]. B ol [
Follow the instructions and wait until “‘;‘?”‘EF”‘“’” S [
the has finished. Then click on [Exit].
Continue at » 5 Program instructions. [ s ]

fig. 4: HDClone boot setup

When creating a CD/DVD, please always use a new, empty
writeable CD/DVD. Otherwise there may be problems when starting
HDClone.

In few cases, no drive is offered for selection at CD/DVD writer although a CD/
DVD writer is available on the system. Usually, this results from already installed
software for the CD/DVD writer (e.g. drivers for direct access to the CD/DVD
writer with Windows Explorer). It reserves the drive in a way that the installation
program cannot access it. If possible, deactivate or uninstall the CD/DVD writer
software. Or create a bootable CD/DVD from that I1SO image, which is also con-
tained in the software package ( » 4.3.2 Creating a bootable CD/DVD).

When using HDClone with storage devices or controllers, which require special



Windows drivers, it has to be used directly on Windows. If there is no Windows
installation available, you can create a bootable Windows XP CD which includes
the drivers needed. It just requires PE Builder and a Windows XP installation CD.

Please download PE Builder from the [@eesuceraii ol e |
Internet at http://www.nu2.nu/pebuild- | = "

ﬂ. The downloaded package allows s;u\m(pammwmuwsmsta\laummes) o
you to create a SpeCial]y Conﬁgured Custom {include files and Folders from this directory) o

Windows XP system, which can be ot lClpetor e
started right off a CD. A plug-in is used

Media aLtput

to integrate HDClone into the PE sys- )

. . . cH\TempiHDClonePE isal [
tem. A corresponding plug-in is to be s W ettt
found at http://www.miray.de/public/ —

support/HDClone-BartPE-Plugin.en.zip.
Please install PE Builder on your system
and unpack the plug-in to the folder fig. 5: PE Builder configuration dialog
pebuilder3110a\plugin. This location

then should contain the new folder HDClone. Now copy hdclone.exe from the
installation package to pebuilder3110a\plugin\HDClone\files. In case the mass
storage devices and controller on your target system will require special drivers,
please copy the driver files to pebuilder3110a\drivers\SCSIAdapter.

( Plugins ] Buid ] [ Exit ]

Then start pebuilder.exe from the folder pebuilder3110a. After few seconds, a
dialog window appears ( » fig. 5). Please enter the path to the Windows XP instal-
lation files in the input field on top. They are to be found on your Windows XP
installation CD. Hence, this field usually contains the drive letter of your CD/DVD
drive - except you have copied the installation files to another location. You can
now choose a name and a location for the boot image by clicking on Create 1SO
image in the box Media output. If another CD/DVD writer is available, you can
immediately create a CD by clicking on Burn to CD/DVD. Otherwise, please cre-
ate an ISO image first.

After clicking on Start PE Builder creates the CD. Depending on your system, this
may take a few minutes. If you did not select Burn to CD/DVD in the previous
step, it is necessary to write the newly created ISO image to CD with your re-
cording software. Please note that the file has to be written to CD directly as an
image. Normal writing will not be sufficient in this case. Instead, please start your
recording software and choose Create from image file (or similar description,
depending on the recording software used).

Start your PC from the CD created. HDClone is to be found at Go » Programs.



You can also create a bootable HDClone floppy disk without the installation pro-
gram with any operating system. For this purpose, the HDClone software pack-
age contains a floppy disk image in the file hdclone.img. You can create a
bootable 3.5°/1.44MB floppy disk from this image with any appropriate disk im-
aging program. After having created a bootable floppy disk, you can start
HDClone on any PC as described in chapter » 5.2 Starting the program.

Under UNIX and Linux you may use the tool dd, which is available
on these systems, with the following syntax:
dd if=hdclone.img of=/dev/fd0.

The HDClone software package contains an ISO image (hdclone.iso). It can be
used to create a bootable HDClone-CD in any operating system and with any
software supporting creation of CDs/DVDs from ISO images. Further information
can be found in the manual of your CD/DVD authoring software.

o Extract the file hdclone.iso from the HDClone software package.

o Start your CD writing software and choose Create CD from image file (or sim-
ilar caption, according to the respective CD writing software).

o Specify the file hdclone.iso as image file.

o Insert a blank CD into the drive and write the CD.

The easiest way of creating a bootable HDClone CD under Linux
is using the software tool cdrecord with the following syntax: cdrecord
hdclone.iso.

After having accomplished these steps you have created a bootable HDClone
CD. From this CD you can start HDClone directly on any PC with a bootable CD/
DVD drive as described in » 5.2 Starting the program.

CD/DVD writing software may refuse writing an ISO image to a
DVD. The HDClone installation program writes DVDs without any prob-
lem. Booting from a DVD created this way also works smoothly.

To start HDClone from a USB key, the PC has to be able to boot from USB media.



Usually the easiest way is to enter the BIOS-Boot-Selector (BBS) and select the
USB key to start from. The PC then boots directly from the USB key instead of the
installed operating system. Depending on the regarding BIOS of the PC, the USB
key is displayed in the BBS menu under its name (e.g. Miray USB), as USB medi-
um, USB-HDD, Removable Device, or a similar caption.

If the USB key is not listed in the BBS menu at all, it is required to activate support
for USB boot media in the BIOS setup first. This setting is to be found under dif-
ferent captions and menu items, depending on the regarding BIOS. In most cases
they are to be found under captions like USB, Boot and Legacy. In BIOS setup
you can also preset booting from USB firmly, usually under the menu item Boot.

You can enter the BBS menu directly when starting the PC with a
certain key on the keyboard, depending on the BIOS. In most cases the
startup screen shows which key to press. For the BBS menu it is = F8
or F12 in most cases, rarely = F11 . BIOS setup usually is called with
the F2 orthe Del key.
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5 Program instructions

The following chapters provide a detailed description on how to operate
HDClone, from the start to the end.

o Note: Depending on the edition you use, there may be differences in the
T, features described in this and the following chapters. Please check » 1.4

Edition overview for the features your edition supports.

5.1 Preliminary steps

If you want to use USB devices for the following copying process, connect the
devices before starting HDClone and leave them connected until the copying
process is finished. Otherwise it is not guaranteed that HDClone recognizes
them correctly. Do not use a USB hub to connect USB storage devices, always
connect the USB storage devices directly to the USB controller or the PC case.

o Note: HDClone can be started directly as a Windows application
(»5.2.2 Windows program) or as a self-booting application (» 5.2.1
Self-booting program). To start the self-booting HDClone, you need a

bootable HDClone CD or floppy disk. You can create it as described in
chapter » 4.2.2 Boot-Setup & boot media.

5.2  Starting the program

5.2.1 Self-booting program

Insert the bootable HDClone CD, floppy disk into the corresponding drive or
plug the bootable USB key to your PC. Switch on the computer or reboot it.
Make sure that the BIOS boots from the respective drive or USB key ( » 4.4 Boot-
ing from USB key). HDClone will then start automatically from the bootable me-
dium and the program screen appears.

o | Note:In case your PC does not boot from the HDClone boot medium,
11, | press F8 , F11 or F12 (BIOS dependent) immediately after turn-
ing on the PC to enter the boot menu and select the HDClone boot

device. Orpress F2 , F10 or Del (BIOS dependent) to enter BIOS
setup and set the required boot device order there.
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5.2.2 Windows program

Start HDClone from the Windows start menu at [Programme] » [HDClone] »
[Start HDClone] or by starting the executable file hdclone.exe from the genuine
HDClone medium or directly from your software package.

5.2.3 Command line program

You may include HDClone in automated workflows like shell scripts or time-trig-
gered tasks. For this kind of usage, there is a command line version of HDClone
(hdclone-cl.exe), to be found in the program folder of HDClone. It is especially
suitable for the following fields of application:

o Calling it from shell scripts or batch files.

o Creating a permanent link on the Desktop or in the Start menu.

o Creating time triggered tasks by calling HDClone through the Task Scheduler.

This allows to integrate HDClone seamless into existing scripts or batch process-
es. You can also create Desktop links for frequently used cloning configurations
to call them easy manually or automatically on demand. Usage of hdclone-cl.
exe is described in detail in » 6.9 Command line interface.

5.3 Program screen

Status field —»
dol——— Quit

u Help

Title of dialog ___|
page

Operating field

Selection graphic —

fig. 6: Program screen

The HDClone program screen ( » fig. 6) contains two fields in a lighter blue. They
are the ‘active’ area of the program; where all information is shown and all op-
eration steps are executed.



32 P

5.3.1 Status field

The upper field is the status field ( » fig. 6). It shows the parameters selected for
the copying process (Copying mode, Source, Target and Options). Thus you at
any point of the program, which parameters you have already selected. Further-
more, the right side of the status field also shows license information.

5.3.2 Operating field

The lower field is the operating field ( » fig. 6). In the upper left of the operating
field is the title of the currently shown dialog page together with a correspond-
ing symbol. In the upper right are two general operating elements: with the help
button [?] you can call up the interactive help at any point of the program
(» 5.5 Help). With the quit button [X] you can quit the program at any time
(» 5.11 Closing the program). At the bottom of the operating field, you find the
buttons [Next] and [Back], for navigating to the next or previous dialog page.

5.4 Operation

To create a copy. you are led through five consecutive dialog pages. where you
can select the individual parameters for the copy and start and control the copy-
ing process. These five dialog pages are shown in the operating field.

5.4.1 Graphical control elements

To control the program, HDClone offers different graphical control elements
(» fig. 7 and fig. 8). The names, used within this manual to designate the differ-
ent elements, are listed and illustrated by examples in the following illustrations.

Check box —»g
List box ———» <—Info box

Button (focused)
Button ————— 8

fig. 7: Graphical control elements (1)
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[ e ———— Close dialog

Percentage — pummmmm———

*— Progress bar

Button (inactive)

fig. 8: Graphical control elements (2)

5.4.2 Operation with keyboard and mouse

HDClone is operated by keyboard and mouse. It is also possible to operate the
program exclusively by keyboard or exclusively by mouse.

5.4.2.1 Keyboard operation

Keyboard operation always refers to the currently focused graphical element.
This element is highlighted by color, brightness, or an additional frame. With the
tabulator key you can switch the focus in turn to the other operating elements.
The following control keys have a function when operating the keyboard:

Key Control element Function
Tab (All) Switch to the next element
Arrow keys List field Select list element
t v Selection graphic Highlight element
Space Button Press button
Selection graphic Select highlighted element
Link Show link target
Return Button Press button (in dialog windows only)
Link Show link target
Esc Window Close window (only windows with x in the
title bar)

(Operating field) Quit HDClone
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5.4.2.2 Mouse operation

Operating HDClone with the help of a mouse is done according to the point-
and-click principle. The right mouse key has no special function. HDClone does
not use drag-and-drop.

5.5 Help

You can open a context-related help window at any point of the program by
pressing the key ~ F1  or the [?] symbol in the upper right corner of the operat-
ing field ( » fig. 6). The help gives you useful hints on the current program screen.
The underlined text links in the help window enable you to jump to other help
topics at any time.

o Note: The program help is designed to give you useful hints when using
T, the program. Please use this user's manual when encountering prob-

lems or requiring more information on a topic.

5.6 Selecting a copy mode

Select the desired copying mode on the first dialog page ( » fig. 9 and fig. 10).
There are two views, basically offering the same options. They differ in how the
copying modes are presented. The classic view is focused on functionality, while
the category view displays the available copying modes task-oriented.

5.6.1 Category view

The category view (»fig. 9) allows
you to choose a copying mode match-
ing the desired area of use (backup,
restore, and cloning). The upper row
of symbols shows the copying modes
referring to entire disks (e.g. hard
disks). The lower row refers to copying
modes for individual partitions. If you
select a copying mode by clicking with
your mouse, it will be displayed high-
lighted. If you want to use the select-
ed copying mode, click on [next]. A
detailed description of the copying modes, their operation and impact can be
found in » 6 Operating principles.

fig. 9: Selecting copying mode (categories)
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5.6.2 Classic view

The classic view ( » fig. 10) offers you
a more functional selection of the
available copying modes. You have
eight options altogether. This is two
more than with the category view,
since the classic view also allows for
choosing » 2.1.1 Unused disk space
and »6.1.5 Drive-to-Partition. Ac-
cording to your choice, a physical
copy, a logical copy, or an image file
will be created or restored. You find a
detailed description of the copy
modes and how they work in » 6 Operating principles.

o | Note: The copy modes drive-to-partition and partition-to-drive are de-
signed for mutual use. In general, it is not possible to copy a working
hard disk installation onto a partition and to use it from there. The instal-

lation rather has to be copied back to a hard drive first. We recom-
mended to rather use a file image in this case ( » 5.6.1 Category view).

fig. 10: Selecting copying mode (classic)

After selecting the copy mode, move to the next step by clicking [next] in the
lower right corner of the operating field ( » 5.7 Selecting data source and target).

When selecting the copy mode, HDClone starts its device and drive recognition.
A small popup will be displayed before the next dialog page will be shown. This
can take one minute or more. The time required depends on the number of
drives connected. If it takes more than five minutes, there may be technical
problem. In this case you find further information in » 7 Troubleshooting.

5.7 Selecting data source and target

In the two following steps, you select the data source and the target for the
copying process. The left half of the operating field shows a selection list. On the
right side is an info box containing details on the currently selected element. Ac-
cording to the selected copying mode, you can select either an entire drive or a
single partition. The following sub-chapters give you more detailed information.
After having selected the data source in the first step, another dialog page ap-
pears for the selection of the target. After these two steps, you come to the se-
lection of the options ( » 5.8 Selecting the options).
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5.7.1 Selecting a drive

When selecting a source or target
drive (» fig. 11) you see the devices
recognized by HDClone in the selec-
tion list. The info box on the right side
shows more details on the selected el-
ement ( » 5.7.4 Drive information).

Select the desired drive and confirm
your selection by pressing [Next] in
the lower right corner of the operating
field and go to the next step.

fig. 11: Selecting a drive
5.7.2 Selecting a partition

When selecting a source or target par-
tition (» fig. 12), the partitions found
are displayed indented under the re-
spective drive, shown in the selection
list. The frame on the right side of the
selection list shows details for the drive
where the currently selected partition
is located on.

Select the desired partition and con-
firm with [Next] to proceed to the
next step. fig. 12: Selecting a partition

5.7.3 Deactivated list entries

There are four cases in which entries in the selection list for source or target are
deactivated and therefore cannot be selected:

o When selecting a source or target partition, the list entries for the correspond-
ing hard disks are always deactivated; only partitions can be selected.

o Since source and target must not overlap, the already selected source drive or
the drive that contains the source partitions is deactivated when selecting a
target drive.

o When selecting a target partition, the already selected source partition or all
partitions of the source drive are deactivated.

o If HDClone recognizes drives which are not supported by the edition used the
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partitions are also deactivated. For further information on the different edi-
tions, please go to » 1.4 Edition overview or http://www.hdclone.com.

Hint: Activate All drives selectable below the details to see the details
. of drives which are recognized by HDClone but not supported by your

edition ( » 1.4 Edition overview).

5.7.4 Drive information

On the right side of the selection list for the source drive/source partition resp.
the target drive/target partition, you find a frame containing details on the cur-
rently selected drive. When selecting a partition, the data of the corresponding
drive is shown here. The following information is available:

Field Description
Controller Type (IDE/SCSI) and number (0-15) of the controller
Channel/De-  Channel used by the drive (primary/secondary) and

vice Connection of the drive (master/slave resp. 0-15)
LUN Logical number of the drive (0-255)
Name Name of the device (as specified by internal drive data)

Serial number  Device serial number (as specified by internal drive data)
Manufacturer  Name of the manufacturer (as specified by internal drive data)
Firmware Version of the firmware (as specified by internal drive data)
Supported Drive type supported by the edition used

o Note: Supported will show Yes if the edition you use supports the se-
ﬂ lected drive. Otherwise HDClone indicates here from which edition on

that drive is supported.

5.7.5 Selecting a file image

When selecting a file image as source [

02.07.2009 - <DIR>

or target (»fig. 14 and fig. 15), the [umswes ooz om

WinXP64-RAW - 03.06.2008 - <DIR>

music.img

- 02.07.2009 - Image (Drive, logical, protected)

recognized partitions are listed. Parti- ~03.07.2009 -
tions of a certain drive are listed be- .
neath the drive in indented form. The
drives themselves cannot be selected.
On the right of the list box, the file im-
age can be selected. The form of the
selection slightly varies depending on
whether the file image will be the tar- fig. 13: File image browser

-75GB




get (» 5.7.5.1 File image as a target) or the source ( » 5.7.5.2 File images as a
source). In both cases [Browser] will open the file image browser ( » fig. 13). It
offers a more convenient layout for folder structures. Use [Cancel] to return
without any changes and [OK] to use the file image selected in the browser.

o Note: If you are running HDClone/W and mapped network drives are
not displayed in the selection list, this may probably be solved as de-

scribed in » 7.7 Mapped network drives.

5.7.5.1 File image as a target

When creating a file image ( » fig. 14),
select the desired partition. In the box
on the right, specify the name for the
file image and the image format: Ful-
limage, Smartimage, RAW, VMDK, or
VHD (» 6.7 File images). To store the
file image in a different folder than
the standard folder, click on [Browser].
Confirm your choice with [Next] in
the lower right to proceed to the next
step.

fig. 14: File image as a target
5.7.5.2 File images as a source

For an image restore ( » fig. 15), select
the partition where the file image is lo-
cated on. Then select the image from
the list on the right to display image
details on the image below the list: im-
age type, creation date and time, and
size. Image type can be an entire drive
or a single partition and the image for-
mat used: Fulllmage, Smartimage,
RAW, VMDK, or VHD ( » 6.7 File imag-
es). Image size has two values: size of
the file image and size of the original
medium. Confirm your selection with [Next] to proceed to the next step.

fig. 15: File image as a source



Use the [SpeedTest] button in the lower right of the operating field to start a
speed test for the currently selected medium. Since this is a pure read test, all
data will remain unchanged. The test shows the maximum speed that can be
achieved for linear reading on the currently selected medium.

If the option MultiCopy ( » 5.7.7 MultiCopy mode) is selected,
the speed test is performed for all selected media at the same time. This
determines the maximum possible concurrent total data throughput of
these media. This is especially relevant for potential use of the Enter-
prise Edition, but also represents a performance test of the entire sys-
tem. The speed, that can be achieved, strongly depends on how the
tested media are connected to the system ( » 6.5.2 Speed).

When selecting the target medium you can use the check box MultiCopy to ac-
tivate MultiCopy mode ( » 6.5 MultiCopy) . In this mode it is possible to select up
to 16 drives or partitions at the same time. For doing so, click on all desired list
entries. The selected entries then will be marked with a dark blue background.
To remove a marked list entry from the selection, it simply has to be clicked
again. You can then use the » 5.7.6 SpeedTest to measure the data throughput
of the selected drives or partitions in parallel operation. Copying to multiple
drives in parallel is only possible with the Enterprise Edition. It allows to copy to
up to 4, 8 or 16 targets at a time, depending on the stage used (Enterprise Edi-
tion 4x, Enterprise Edition 8x or Enterprise Edition 16x).

You can activate the MultiCopy option in all editions of HDClone,
even in the Free Edition, to check the achievable speed of the Enter-
prise Edition on a certain system. Please note that the achievable speed
strongly depends on the interfaces used (most suitable: IDE, SATA, and
SCSI) and the drive combinations (only use master drives with IDE).

MultiCopy mode can also be used for restoring from file images to
restore the contents of an image file to up to 16 targets at a time
(» 5.7.5.2 File images as a source).

On the dialog page Options, you can set the options with which you want the
following copying process to be executed. The individual options are described
below. After choosing the required options, click [Next] to proceed to the next
dialog page where you can start the copying process ( » 5.9 Copying data).
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5.8.1 Verifying

The option Verifying is an exception to the options described in this chapter
(» 5.8.3 General options). This option has no influence on the copying perfor-
mance itself, but offers the possibility to synchronize the data of the source and
target after the copying process. However, the whole process of copying and
verifying then normally takes approximately the double amount of time. Choose
this option according to your needs of copying and your time available.

Warning: You should not activate verification when you copy hard

disks containing defects (data rescue). Physical damages on the drive
could spread faster due to the additional stress. Furthermore, a verifica-
tion of hard disks with defects has no real expressiveness.

5.8.2 Locked options

The options show different availability and selectability, depending on the copy
mode selected. Locked options cannot be modified, but the displayed setting is
valid. » fig. 16 shows the different states.

s Gy inactive

inactive &
locked

fig. 16: Selecting the options (creating an image)

5.8.3 General options

The column General, contains options that refer to all modes.

Option Meaning

Verifying Compares the data of source and target after copying.
Not to be used for data rescue, as it yields unnecessary
additional stress for a damaged drive ( » 5.8.1 Verifying).
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Option Meaning

Copy free areas On a partly partitioned source, HDClone works faster if
free areas are not included. In case of special media (for
example dynamic disks, RAID) it may be though be re-
quired to include free areas, though.

5.8.4 Cloning options

This column only appears in the cloning modes (not when creating an image).

Option Meaning
SmartCopy Copying only: Create a logical copy ( » 6.1.2 SmartCo-
PYy).

Defragmentation Copying only (NTFS+FAT): Reorganizing the file system.

5.8.5 Backup options

These options are only displayed when creating images.

Option Meaning
Store downsizing Store information needed to downsize NTFS and FAT
info partitions when restoring, otherwise partitions can only

be restored at their original size (or larger).

Store defrag info Store information needed to defragment NTFS and FAT
partitions when restoring, otherwise partitions cannot be
defragmented during restoring.

Compression Creates a file image with the selected compression (Nor-
mal/Quick/Strong) ( » 6.7.6 Compressed Images).

Password protec- Use a password to protect your file image ( » 6.7.7 Pass-

tion word-Protection) and choose to use file image encryp-
tion ( » 6.7.8 Encryption).

Maximum image Defines the maximum size of the file blocks stored within

file size an image. To be compatible with different file systems,

the default is 2,047 MB. For burning an image to CD,
DVD or BD later, you may specify a different value (CD:
700 MB | DVD: 4.700 MB | BD: 25.000 MB).

5.8.6 Restore options

These options are only displayed when restoring images.



42 Program instructions

Option Meaning
Defragmentation NTFS+FAT only: Reorganize file system during copying.

5.8.7 Options for source and target

These settings refer to the drives selected as source and target.

Option Meaning
Sector area Exactly definable copying area ( » 6.4 Area copy).
4k alignment Target only: Will align the partitions copied automatically

to 4 KB borders on the target medium.

Driver adjustment ~ Target only: Activate inactive AHCI and IDE drivers.

MediaDirect (Dell)  Target only: Deactivate MediaDirect software.

Error threshold Target only (MultiCopy): Sector error threshold. Media
encountering more than the specified number of errors
during copying will be suspended from copying to allow
the remaining media to be copied at maximum speed.
For example, a good value for practical use is 32,000.

5.8.8 Advanced options

Find more settings via [Advanced op- (EEEIIss

1 H 1 H 1 eneral ource arge

tions]. This will open a dialog you find || g o e

i 1 T ¥l saferescue W oma Womea
more Settlngs' It Opens a dlalog Wlth M cachedMemory W Read ahead B Read ahead

i - SharedMemor, W write cache W write cache
more Optlon ( } ﬁg. 1 7) The Sepa ra Animation ’ B Multisectar PIO W Multisector PIO
tion into different columns is the same ElHotcopy / Liveimage W recovery via pio BlRscovery vis PIO

. i [ &void exclusive read access M Cooling phase W Cooling phase

as on the dialog page Options. B copy swap fies

fig. 17: Advanced options
5.8.8.1 General

These options refer to the general features of a copying run.

Option Meaning

FastCopy Special copy algorithm. May increase the regular copy
speed up to the double.

SafeRescue Special algorithm for data recovery. Tries to recover large
areas first. Can also stay turned on for normal copies.

CachedMemory Use fast intermediate memory.

SharedMemory Use fast data transfers.

Animation Switch off copy animation.
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Option Meaning
HotCopy HDClone/W only: This option allows for clones or file
Livelmage images of the system drive or of media, which are used

by other programs at the same time.

Avoid exclusive read HDClone/W only: In Windows, HDClone usually tries to

access

Copy swap files

reserve the source drive for exclusive access at first. If
this option is selected, HDClone will try to use HotCopy
mode or Livelmage mode first.

Creating images only: Usually, it is not necessary to store
the files pagefile.sys and hiberfil.sys in the file image. For
cloning, this option is always activated.

5.8.8.2 Source and target

Specific Options for source and target. They are not available under Windows
and therefore are not showing up under HDClone/W.

Option Meaning

IRQ In IRQ mode, source and target are optimally synchro-
nized. Only this leads to a maximum copy transfer rate.

DMA For highest transfer rate and the shortest copying time.

Read cache
Write cache
Multi-sector PIO
Recovery via PIO
Cooling phase

Use fast read buffer.

Use fast write buffer.

Increases speed in PIO mode by about 10%.

Optimal recovery of defective sectors.

Only if problems occur ( » 7.6.2 Other device problems).

5.9 Copying data

The dialog page Copy data ( » fig. 18)
lets you start the copying process.
Check in the status field if copy mode,
source, target, and options are select-
ed correctly. If needed, go back with
[Back] in the lower left corner and ad-
just the settings. Click [Start] to start
the copying process.

fig. 18: Dialog page ,Copy data’
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5.9.1 PartitionSelect

The PartitionSelect dialog (» fig. 19)
will prompt you to choose the parti- o
tions to copy and which to exclude s s

from copying. If the total size of the e & |
partitions to be copied exceeds the | s

total capacity of the target, the graph-

ical bar will be marked in red. In this
case, exclude partitions you do not re-
quire on the target until the remaining fig. 19: Dialog Select Partitions’
partitions fit on the target. Alternative-

ly, you can click on [Cancel] to choose a different combination of source and
target for creating the copy.

se select the anes you want
umber to select.

Size. 1968
File system: NTFS
Name. VOLUME

cancet Continue >__| [ skip adjustment >

The default setting is to have all partitions selected, so you may accept that by
just clicking [Continue]. Otherwise select which partitions to exclude from copy-
ing by clicking on the check symbol (W) beneath the partition number. The
check symbol will then change to a lock symbol ()A It signals that the partition
will be excluded from copying. When clicking on the lock symbol, you can acti-
vate the partition again and the check symbol appears again. When you have
selected all partitions as desired, click on [Continue].

In case you want to copy all partitions and to skip the adjustment step (» 5.9.2
Adjusting partitions), use [Skip adjustment]. Any previous partitions selection will
then be ignored and all partitions will be copied in their original size and original
location as given on the source. For more information, see » 6.6 PartitionSelect.

5.9.2 Adjusting partitions

In case partition sizes can be altered, a
dialog window appears, before start- |
ing the copying process (¥ fig. 20). It | own ot
allows you to adjust the size of several

or all partitions to fit on the target me-

dium as desired. Positions and sizes of

ition sizes by olicking and dragging or with cursar keys and (+] / (-

Partition 4

the partitions on the target medium || we

size. 12068

are displayed graphically in a bar. Each | [fiez=em v

Name! Volume

partition has a cipher or - from the = contings > | [oip adjustment >
tenth partition on - a letter assigned to
it. If you click on a partition in the bar,
the box on the lower left will display additional information on the selected par-

fig. 20: Adjust partitions’ dialog



tition. Below each partition number, there is either a double arrow (B the de-
fault setting), showing that the partition size can be altered, or a lock-symbol (ﬂ
). indicating that the partition size is fixed. By clicking on these symbols, you can
toggle between both modes. This allows to keep the original sizes of certain par-
titions, while changing others or have them adjusted automatically.

Given are system partition (C:) and two data partitions (D:
and E:). When migrating to a larger hard disk, only the latter two are to
be up-sizead, but not the system partition. First, click on the symbol be-
low the system partition to have it change to the lock-symbol. This will
keep the system partitions's size fixed. Then choose Automatic adjust-
ment to have the data partitions resized proportionally to the newly
available space. Then click [Continue].

FAT, NTFS, and ext2/ext3/ext4 partitions can be increased, FAT and NTFS parti-
tions can also be decreased in size. Each partition can be shrinked to the mini-
mum amount of space required by the data stored on this partition. Up- and
down-sizing can be accomplished either automatically, proportional to the size
of the target medium or manually to an arbitrary size. The original size of the
partition is displayed in light green, the minimal partition size achievable by
downsizing in dark green. The additionally assigned space when enlarging a par-
tition is displayed in striped light green. The size of partitions displayed in black
cannot be altered. Free space not assigned to any partition is displayed in white.
There are three options for how to handle free space on the target medium
(»5.9.2.1 Keep original sizes, 5.9.2.2 Automatic adjustment, 5.9.2.3 Free adjust-
ment). Select the desired option. In case of Free adjustment, make the desired
changes. Then click on [Apply adjustments] for having the selected adjustments
become effective. If you click on [Continue without adjustment] , the following
copying process will transfer the partitions of the source to the target medium
without any changes. Clicking [Cancel] will bring you back to the dialog page
Copy data, and will cancel any changes made.

To transfer the original partition layout to the target medium, click
on [Continue without adjustment]. The option Keep original sizes will
keep the original partition sizes, but may alter their absolute positions
on the medium by shifting them towards the beginning of the medium
for a better utilization of free space.

The original sizes of partitions on the FH
source will be kept on the target me-

fig. 21: Option ‘Keep original sizes’
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dium (» fig. 21). The partitions themselves will be “shifted together” at the begin-
ning of the target, if possible. This approach is useful since it closes gaps between
partitions, gaining additional space, which is made available in one single block
at the end of the medium.

5.9.2.2 Automatic adjustment

Free space on the target medium wil f—— B

be apportioned completely to the in-
dividual partitions, proportional to
their respective size (» fig. 22). This increases the partitions’ sizes according to
their part of the full size of medium. Calculation of the size proportions is han-
dled automatically by HDClone.

fig. 22: Option Automatic adjustment’

5.9.2.3 Free adjustment

Youcan adjust the apportioningofad- =@ B0 | |

ditional space on the target medium
to the individual partitions by yourself
(» fig. 23). You can change the size of a certain partition by clicking and dragging
the corresponding area on the graphical representation.

fig. 23: Option ‘Free adjustment’

5.9.3 Security query

Before the final start of the copying [EEEEIIEIR
process, a security query (»fig. 24), _'5 S .
appears Where source and tal’get Of L) Drive: #1 HDS728080PLA3E0 (78,532 MB)

the copying process as well as corre- L SN,

sponding security notes are displayed. The content af the target aren il

Click [Start copying] to start the copy- b e YL B v ot s
ing process and [Cancel] to return approx. 77,565 MB overhang will not be copled.
without starting the copying process. Abort start copying

fig. 24: Security query

Warning: Any data in the target area will be irretrievably deleted by
% starting the copying process. Then even a data recovery software will

not be able to retrieve the overwritten data.
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5.9.4 Copy animation

In the center of the operating field, there is the copy animation Especially if oth-
er indicators only change rarely, for example in case of read or write errors, the
copy animation shows that HDClone is still running.

5.9.5 Status indication

On the left and right side of the operating field, you see the status indicators.
They contain information on the current status of the copying process.

Status Meaning

Sectors processed  Absolute number of sectors already copied.

Buffer size Size of the internally used buffer.

Read errors Number of the read errors occurred. May decrease if

errors can be fixed. When starting the optional verifica-
tion run, this value is set back to zero.

Write errors Number of the write errors occurred. May decrease if
errors can be fixed. When starting the optional verifica-
tion run, this value is set back to zero.

Running time Time passed since the start of the copying process.

Time remaining Estimated (!) time remaining for the entire copying pro-
cess (incl. the optional verification run) based on the cur-
rent copying speed. Note: The rest time can strongly
increase in case of occurring read or write errors.

Data rate Average data rate, which has been attained up to this
point of time. The indicated value refers to the amount
of copied data. The actual throughput is twice as high (x
MB copying = x MB reading + x MB writing).

Verification errors  This indicator is only used if the Verifying option is on.

5.9.6 Percentage indication

The percentage indicator ( » fig. 8) is located below the copy animation, show-
ing the progress of the current run ( » 5.9.8 Course of the process) in percent.
5.9.7 Progress bar

The progress bar ( » fig. 8) below the percentage indication visualizes the prog-
ress of the current run. Which run (» 5.9.8 Course of the process) is currently
processed is shown on the left above the progress bar.
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5.9.8 Course of the process

The process consists of up to three runs: the copying process itself, an optional
error recovery run (option SafeRescue active, » 5.8.3 General options), and an
optional verification run (option Verifying active, » 5.8.3 General options).

5.9.9 Interrupting the running process

You can use [Stop] at any time to in- [EEEIETETR
terrupt the process (»fig. 25 and /| e e
ﬁg 26). You may then continue the £) The target medium will nat contain a complete copy.
process (click on [Continue copying] Continue copying||__Abort copying |

or [Continue verifying]) or abort it
completely (click on [Abort copying]
or [Abort verifying], » 5.10.1 User abort). As long as you select neither option,
the current copying process remains interrupted.

fig. 25: Abort dialog copying process

5.10 Termination of the copying process

5.10.1 User abort

If you interrupt a running copying pro-  [EEIETET
cess or verification run by clicking 61 G0 T 0 i) s ey
[Stop] (»5.9.9 Interrupting the run. | & Tessterme st oo
ning process), you can definitively
abort the process in the dialog win-
dow which then appears (»fig. 25 fig. 26: Abort dialog verification run
and fig. 26) by clicking [Abort copy-

ing] or [Abort verifying]. You then obtain a final report ( » 5.10.4 Final dialog)
upon the prematurely terminated process.

o Note: Unlike an aborted copying run, an aborted verification run has no
influence on the copied data. The copy itself is already finished at that

point of time.

Continue verifying|  Abort verifying |

5.10.2 Regular termination

After up to three runs (» 5.9.8 Course of the process) without a premature
abort, the copying process is regularly finished. You then obtain a final report
upon the complete copying process in a dialog window ( » 5.10.4 Final dialog).



5.10.3 Adjust media parameters

After finishing the copying process, a dialog
for adjusting media parameters appears
(» fig. 27). Since HDClone creates a 1:1 copy,
the data from the Master Boot Record (MBR)
and of the boot sector(s) are also copied to
the target medium. As this characteristic of a
1:1 copy may yield problems in some cases,
HDClone offers to adjust media parameters.

HDClone automatically sets parameter val-
ues, which are optimal for the respective me-
dium in most cases. They usually just need to
be confirmed. A manual change of the preset
parameters is only needed in exceptional cas-
es. The parameters refer to the Master Boot
Record (=MBR/GPT) and to any known boot
sector(s) and are grouped correspondingly.

want to abstain any adjustment.

Termination of the copying process
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‘Adjusl target manually )

Geometry used
D MNarmal ©Large ®LBA O User

cE] HzE] s[E ]

Master boot record

Adopt partition 1D
old: 027 (HPFS/NTFS), new: OxB (FAT32)
Adjust partition size
old: 27,227 MBE, new: 2,346 MB
m
m

Boot sector(s)
Adjust offset

[ adjust CHS layout
[l Patch boot code
I Change wolume ID

Adjust | No changes ‘

fig. 27: Adjustment dialog

Important: In case you adjust the target medium, it will no longer be an
absolute 1:1 copy. Especially in case of forensic analysis, you might

Parameter Meaning

Geometry used

To boot from the medium, the device geometry

has to match the geometry set in BIOS.

Adopt partition ID
Adjust partition size

Use same partition type as on the source medium.
Set the space reserved for the target partition to

the size needed for the partition copied.

Adjust CHS layout

Use the values set under Geometry used for ad-

justing the MBR or the boot sector(s).

Reset disk signature
Adjust offset

Patch boot code
Change volume ID

Reset unique media signature.

Adjust real partition start address in boot sector(s).
Avoids boot problems on older hardware.

Create a new ID for the partition. Required when

source and target work in the same PC.

When the parameters and options are set as desired, click on [Adjust] to modify
the medium or click on [No changes] to leave the medium unchanged.
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Note: In case of a copy with several target media (Enterprise Edition
only), the dialog appears only once. The selected adjustments are then

©

5.10.4 Final dialog

carried out for all target media.

A complete image has been created.
The image has not been verified.

Source
Drive:

Target
Drive:
Partition;
Image:

Elapsad:

Sectors copied
Read errors:
write errors: o

Data copied:

#4 WDC WDBODAAJS-00WAAD (76,319 MB8)

#5 WDC WDBO0AAJIS-00WAAD (76,319 MB)
#3 FAT32 logical (32,984 MB)
Backup

13,805,600
0

0451
6741 M8

Another copy | Quit HDClone | Details | _store report

fig. 28: Final dialog

After termination a final report ( » fig. 28) with the following information appears:

o A complete copy has been created: The copying process has been finished
without an abort (even if the verification run has been aborted).

o The copying process has been aborted: In case the copying run has been
aborted before its regular termination.

o The copy has not been verified: No verification run or the copying process

has been aborted.

o The copy has been only partly verified: The verification run was aborted.

o The copy has been verified: Verification was terminated without an abort.

Field Meaning
Source Source drive/partition of the copying process.
Target Target drive/partition of the copying process.

Copied sectors
Read errors
Write errors
Verification errors
Runtime

Total number of copied sectors.

Total number of read errors occurred (w/o verification).
Total number of write errors occurred.

Total number of errors occurred during verification.
Time required for the entire process..

You can start another copying process by clicking [Another copy] or end the
program by clicking [Quit HDClone] ( » 5.11.2 Good-bye screen). The [Details]
button will open another dialog with more details on each drive.



Use [Store report] to create a detailed cloning re-

port and store it as a text file (» 6.10 Store final | gaye finat report on:
report). Select the drive you want the report being
stored on (» fig. 29). Clicking [Create] will store
the report to the selected drive in the file
hdclone.<x>.txt (<x> = consecutive number), lo-
cated in the root directory (for example X\
hdclone.1.txt). =
Create Cancel

Data
Yolume
Backup
usB

E:
F:
3:
K:

fig. 29: Store report

You can end HDClone at any time by =

clicking the end symbol [X] in the up-

per right corner of the operating field ﬁ Do you want to guit HDClone now?
(» fig. 6) or by pressing Esc . The end

dialog appears ( » fig. 30) where you ves|| no |

can quit HDClone by clicking [Yes] or

return to the program by clicking [No]. fig. 30: End dialog

After the termination of HDClone, ei-
ther via the end dialog (» 5.11.1 End
dialog) or via the dialog window with
the final report ( » 5.10.4 Final dialog),
a good-bye screen appears ( » fig. 31).
You can then shut down the computer
or reboot it.

fig. 31: Good-bye screen

If you don't want to start HDClone when starting the computer
the next time, remove the HDClone boot medium from the boot drive.
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6 Operating principles

HDClone can handle entire hard disks as well as individual partitions. Clones can
be created directly to target disks or via file images. HDClone offers different
modes and options for these use cases.

@ Important: For data rescue, create a full BitCopy ( » 6.1.1 BitCopy) or a
o RAW image ( » 6.7.3 RAW images) of the entire disk first. You can then

try different recovery attempts without putting the original data on risk.

6.1 Copying modes

The copying modes offered by HDClone aim to cover as many use cases as pos-
sible. As long as you do not overwrite any areas containing data which is still
needed, you can try every copying mode without any risk since the original
drive remains unchanged.

6.1.1 BitCopy

BitCopy (physical copy) creates a complete or partial ( » 6.4 Area copy) clone
of a storage medium. This clone is bit by bit identical with the source, since each
sector of the source will be copied exactly to the same sector on the target. A
BitCopy will always be created automatically, if the SmartCopy option ( » 5.8.4
Cloning options) has not been selected.

Important: For a complete BitCopy of all areas of the source, also select
@ the Copy free areas option. This is especially required when performing

data rescue or forensic safekeeping of data.

6.1.2 SmartCopy

For cloning disks with SmartCopy ( » fig. 32), _  SmartCopy
activate the SmartCopy option ( » 5.8.4 Clon- 'g) ogical 1:1 ¢
ing options). SmartCopy mode can be ap- ' 4
plied to entire hard disks or other media as
well as to single partitions. SmartCopy cur-
rently supports NTFS, FAT, ext2-4 file systems. Partitions with other file systems,
will be copied in BitCopy mode, even if the SmartCopy option is activated.

|
ac

fig. 32: SmartCopy

With SmartCopy (logical copy) HDClone only takes those areas of a storage me-
dium that are occupied by the operating system and other files. Any unused ar-
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eas will not be copied. Since in most cases only a part of the total capacity of
storage media is occupied, SmartCopy saves - depending on the amount of
data stored - some of the time needed for a BitCopy. For this reason, SmartCopy
usually is by a multiple faster than BitCopy.

o Note: SmartCopy evaluates file system and depends on file system data
T, being consistent and free of errors. Otherwise the copy may contain er-

rors, too. In case you are not sure, you may check the source with
chkdsk /f before cloning.

SmatCopy also creates an exact clone, but in contrast to BitCopy, only copying
the used areas of the medium. For many cases of use, this mode is preferable,
since it delivers the same result in less time.

Hint: Since it is only a clone, you can always try SmartCopy mode first.
If it turns out not to be sufficient for your individual case of use, you can
still create a BitCopy.

Warning: Never use SmartCopy mode for » 2.2 Data rescue, for copy-
ing defective or inconsistent file systems, or for » 2.7 Forensic data
safekeeping. It is recommended to create a BitCopy in these cases.

6.1.3 Drive-to-drive

Drive-to-Drive creates a direct clone from
one medium to another. You can choose

) =
between a SmartCopy or a BitCopy, de-
pending on the actual setting of the Smart-
Copy option ( » 5.8.4 Cloning options). It is
recommended to use this mode even for
copying individual partitions. You can then use » 6.6 PartitionSelect to choose
the partition(s) to be copied to the target. If source and target have different
sizes, you can » 5.9.2 Adjusting partitions manually or automatically.

fig. 33: Drive-to-drive

Drive-to-Drive is suitable for the following areas of use:

o Migration of an existing operation system installation

o Data rescue (only in combination with » 6.1.1 BitCopy)

o Backup and restore

o Rolling-out installations on individual systems (deployment)
o Copying proprietary file systems and data formats

o Safekeeping data for forensic analysis and evaluation
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6.1.4 Partition-to-partition

Partition-to-Partition creates a direct clone

of an individual partition, either as a Smart-

Copy or as a BitCopy, depending on the —=>

setting for the SmartCopy option ( » 5.8.4

Cloning options). Target size can be ad-

justed manually or automatically before fig. 34: Partition-to-partition
copying ( » 5.9.2 Adjusting partitions).

Partition-to-Partition is suitable for the following areas of use:

o Relocating a partition

o Rescue of an individual partition (only in combination with » 6.1.1 BitCopy)

o Backup and restore of an individual partition

o Copying of proprietary partitions

o Safekeeping data of individual partitions for forensic analysis and evaluation
o Note: In case of doubt, always use Drive-to-Drive mode. It also adjusts

the partitioning scheme, yielding the same or even better results in

most cases (for example regarding bootability).

6.1.5 Drive-to-Partition

Drive-to-Partition stores the contents of an
entire hard disk or any other storage me-

dium on a partition. This mode uses a par-
tition as an intermediate storage for a drive
image, which can be restored with Parti-
tion-to-Drive at a later point in time.

o Note: The data stored on the target partition is usually not accessible
Tl directly and the partition will be displayed as unformatted under Win-

dows. For restoring the data, » 6.1.6 Partition-to-Drive is used.

fig. 35: Drive-to-partition

Drive-to-Partition is suitable for the following areas of use:

o Rescue of several storage media onto one single drive

o Backup of several storage media

o Backup of the data from several drives to one single drive

o Temporary or intermediate storage of entire drives
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Hint: This copying mode has been introduced prior to file images. In the
current version, file images ( » 6.7 File images) are the more versatile,

preferable, recommendable, and better alternative.
6.1.6 Partition-to-Drive

Partition-to-Drive will overwrite an entire
hard disk or other storage medium with
the data from a partition. This mode is
used to restore drive images , created with
» 6.1.5 Drive-to-Partition before.

==

fig. 36: Partition-to-drive

Note: Partition-to-Drive usually only makes sense in combination with
» 6.1.5 Drive-to-Partition. For storing and recovering storage media im-
ages, file images ( » 6.7 File images) are the more versatile, preferable,
recommendable, and better alternative.

6.2 Size differences

To create a real BitCopy, source and target must have exactly the same size.
HDClone is also capable to create physical copies if the size of source and target
differs. But the result will not be an absolutely identical clone.

Hint: The following subchapters refer to the usage of » 6.1.1 BitCopy.
With » 6.1.2 SmartCopy the contents of the source can usually be ad-

justed automatically to the size of the target.

6.2.1 Equal size

If source and target have exactly the same size, » 6.1.3 Drive-to-drive mode is
selected, and a complete BitCopy is set up, HDClone creates an absolutely iden-
tical copy. On this clone - provided the process was error-free - all sectors on
the target are 100% identical with the source.

6.2.2 Small to large

If the source is smaller than the target, HDClone clones all source data, from the
beginning of the source, onto the target medium. The area at the end of the tar-
get medium, which is larger than the source, remains unaffected. The unaffected
area remains possibly unused during a later usage, such a copy is usually compa-
rable to a real clone as far as the capacity of use is concerned because the target
contains entirely all data of the source (in contrast to » 6.2.3 Large to small).



If the source is bigger than the target, HDClone copies only the data which also
fits onto the target. This data is copied from the beginning of the source to the
beginning of the target medium. The data, which is larger than the target, is not
copied and is missing on the target. Generally, such a copy is unusable or only
very restrictedly usable because possibly necessary data can be missing. How-
ever, if you make sure before copying (e.g. by defragmentation), that all valid or
necessary data is in the front part of the source medium and that this area is not
larger than the target medium, a copy onto a smaller target medium can also be
successfully used. This also applies if you have copied a smaller source onto a
larger target ( » 6.2.2 Small to large) and if you copy back the (unchanged) data
onto the original medium or onto a target of the corresponding size.

HDClone tries to troubleshoot occurring sector errors the best possible. If this is
not possible, the errors will be counted in a corresponding error statistic.

In case of read errors, HDClone uses different strategies in order to recover
these sectors. The time used for that depends on the type and size of medium
used. For each sector, several seconds up to minutes can be needed for the re-
covery attempts. Therefore, it is recommended to always activate the option
SafeRescue ( » 5.8.3 General options) since handling of defective sectors then
will be done after copying all intact areas has been finished. The process can
then be aborted if it takes too long without losing the data of the intact areas.

During the copying process, read errors can only occur on the source medium.
HDClone then tries to read the defective areas immediately after the termina-
tion of the copying process (option SafeRescue, » 5.8.3 General options) within
a separate error recovery run ( » 5.9.8 Course of the process). During the error
recovery run, the number of the indicated read errors can reduce depending on
the areas on the source, which could be recovered.

Read errors occurring during verification are counted as verifica-
tion errors ( » 5.9.5 Status indication). Since at verification time, cloning
has been finished already, there will be no further error recovery.



Write errors can only occur during the copying process and only on the target
medium. HDClone then tries to read the defective areas immediately after the
termination of the copying process (with the option SafeRescue, » 5.8.3 Gen-
eral options) with the help of special data recovery strategies within a separate
error recovery run (» 5.9.8 Course of the process). During the error recovery
run, the number of the indicated write errors can decrease depending on the
recoverable areas on the target.

When the option Verifying ( » 5.8.1 Verifying) is activated, HDClone executes a
verification run (» 5.9.8 Course of the process) after the copying process. A
verification error is counted if the data of two sectors on source and target do
not correspond. Furthermore, read errors, which occur during the verification run
in one or both of the areas to be compared, are also counted as verification er-
rors. The number of verification errors gives you absolute information on how
exact source and target correspond to each other after cloning.

Verification will only be performed on sectors that have been
copied previously. Since SmartCopy only will copy data from used sec-
tors, verification will only compare these sectors.

In case of an area copy, not the entire storage medium (drive/partition) of
source or target (or both) will be used, but only a partial area.

The dialog page Options provides the possibility to specify an exactly definable
sector area for source and target (» 5.8.7 Options for source and target). To
specify a sector area, activate the check box Sector area and enter the starting
(from) and the ending (to) sector of the area. These sectors are interpreted as
the first and the last sector of the area, i.e. they are included with the area.

Counting starts with ‘0’ (= 1st sector of the medium), so all further
sector numbers have to be decreased by 1 (e.g. from = 0, to = 99999
defines the first 100000 sectors on the medium as an area).

Only use area copy if you are completely aware of its func-
tioning. A sector area, which has not been defined properly, may lead
to data loss or render the result unusable.



Sector area means a contiguous area of sectors on a storage medium. In case of
partitions, it is specified relative to their starting positions. HDClone will then
copy the first sector of the source are to the first sector of the target area and so
on. Compared to a normal BitCopy, the main difference is that the defined par-
tial area is cloned instead of the entire drive or partition.

Sector area from = 0, to = 31. For drives this defines the (ab-
solute) first 32 sectors. The absolute position of the first 32 sectors of a
partition depends on its (absolute) start on the drive.

In case of a MultiCopy (mass copy) the contents of the source are copied on
multiple targets at the same time. As a result there is a huge benefit regarding
time and performance, since the source data only has to be read once and the
data can be written on multiple targets at the same time.

A MultiCopy generally works the same way as a single copy. A soon as the op-
tion MultiCopy has been selected on the target dialog page (» 5.7 Selecting
data source and target), two or more targets can be selected in the list. The re-
maining steps are just the same as for creating a single copy.

When creating a MultiCopy, the result on a single medium is
identical with the result of a single copy. Even the values for automatic
resizing will be calculated separately for each target.

Mass copying yields an enormous advantage in speed compared to single cop-
ies. In case of optimal connected media ( » 6.5.3 Different media) , speed in-
creases straight proportional with the number of target media. For example, a
fourfold copy yields about four times the data throughput of a single copy.

MultiCopy can be used with an arbitrary combination of drive types. Differences
in performance of different media types may have an impact on the total per-
formance. It is recommended to use IDE drives configured as master only.
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6.6 PartitionSelect

Partitions on the source are displayed
in a graphical bar ( » fig. 37) and num-
bered (with letters after the ninth par-
tition). Beneath the partition number,

1 a
v

there is a check symbol (, default || [rmee ., Eaipibyied
setting), if the partition will be includ- | |fiomen s

ed in, or a blocking-symbol (&), i this e v
partition will be excluded from the

clone. Click on these symbols, to in- fig. 37: PartitionSelect dialog

clude or exclude any partition individ-
ually. Changes to the total size by selecting and de-selecting partitions will be
displayed.

PartitionSelect provides a way to transfer only certain partitions and to leave
others out. Hence, you can use PartitionSelect to reduce the storage size re-
quired for the target.

6.7 File images

Besides direct clones, HDClone is also capable of storing images of a medium
into a file. An image contains the same data as a clone. When an image has been
restored to another medium, the result is the same as if it had been copied di-
rectly from the original source.

6.7.1 Fulllmage

A Fulllmage (physical Image) stores - analog to a BitCopy - all sectors of the se-
lected partitions and optionally all sectors in between (Copy free areas, » 5.8.3
General options) in a file image.

6.7.2 Smartimage

A Smartimage (logical Image) stores - analog to a SmartCopy - only those areas
of a medium that are occupied with file system data. A Smartimage usually re-
quires much less disk space and time for creation than a Fulllmage.

6.7.3 RAW images

RAW images are also physical images. They contain the same data like Fulllmages
(including Copy free areas, » 5.8.3 General options). HDClone just uses a spe-
cial file format for Fulllmages, which optimally supports HDClone specific fea-



tures (e.g. SafeRescue) . RAW images contain data in the same linear order as it
is stored on a medium. This makes it faster and easier to process image files with
third party programs, especially when mounting them in » 8 Miray Virtual Disk.

RAW images created by HDClone automatically contain a VMDK
file required to mount them directly as virtual drives in VMware or oth-
er virtual machines ( » 6.7.4 Dynamic VMDK and VHD images).

IOn addition to its own image formats, HDClone is also able to create dynamic
VMDK and VHD images. These only contain used areas of the source and there-
fore are usually much smaller than » 6.7.3 RAW images (analog to » 6.7.2 Smar-
timage). Due to their technical characteristics, VMDK and VHD images are often
a little bit larger than Smartimages. And it is not possible to exactly calculate their
final size in advance. During creation, this may lead to a deviation from the pre-
dicted size.

Compression and encryption are not available for VMDK and
VHD images. In this case, select a Smartimage and the appropriate op-
tions instead ( » 5.8.5 Backup options).

VMDK and VHD images created with HDClone can be used as virtual drives in
virtual machines. For further information, please refer to the manual of your ver-
sion of VMware or VirtualPC. From Windows 7 and Windows Server 2008 on,
you can also mount VHD images as virtual drives using the Disk Management
tool (diskmgmt.msc).

» 8 Miray Virtual Disk can mount both formats under Windows as virtual drives.
This allows you to access the files and folders stored in them without opening
the image in a virtual machine.

A virtual VMDK or VHD drive mounted with Miray Virtual Disk
can be read AND written. But changes are not stored directly in the im-
age. But you can use the virtual drive to create a new image including
all changes ( » 8.7 Copy to other Image formats).

When creating a RAW-Image ( » 6.7.3 RAW images), a VMDK file will be created
automatically. Opening the HDClone file image with VMware, you will be dis-
played a VMDXK file of the same name. You then can select and use it. The VMDK
files HDClone creates comply with HWversion=4 and are specified to be used
with the following versions of VMware:

o VMware Player starting from version 1.x

o VMware Workstation starting from version 5.x
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o VMware Server starting from version 1.x

o VMware ESXi starting from version 3

6.7.5 Usage

When choosing a copying mode ( » 5.6 Selecting a copy mode) you can specify
Image as source (= restore image) or target (= create image). You can create
Fulllmages of any media supported by HDClone. For creating Smartimages, it is
required that the source medium is formatted with FAT, NTFS, ext2/ext3. With
HDClone/S you can use FAT32 or NTFS formatted media for reading and writing
image files. HDClone/W also supports network drives and network shares.

6.7.6 Compressed Images

When creating a file image, the dialog page
Options ( » 5.8 Selecting the options) offers
you to create a compressed image. Please
choose the option Compression to have
HDClone compress the file image. You will
then be able to choose between normal
compression (default), QuickCompress and
StrongCompress ( » fig. 38). QuickCompress fig. 38: QuickCompress
offers a lower compression ratio than Normal

compression, but in run it requires almost no additional runtime. To create back-
ups quickly while saving some space, please choose QuickCompress. To maxi-
mize the amount of saved space, please choose StrongCompress, which needs
more time for its maximum compression.

ompression
ller file image:

When using file images in HDClone, there is - except file sizes - no difference
between compressed and uncompressed file images from the user's point of
view. Creating compressed file images will consume more time than decom-
pressing file images when restoring. Therefore, transfer speed when restoring
compressed file images is usually faster than creating compressed file images.

o Note: Activating compression usually leads to a lower copying speed,
since compressing data consumes extra time. But in some cases, creat-
ing compressed file images may even lead to a higher copying speed.
Especially when the medium containing the file image is relatively slow,

for example slow USB keys, mass storage media connected via USB 1.1,
or slow network drives and when using QuickCompress.



When creating file images, you can protect them with a password (option Pass-
word protection, » 5.7.5.1 File image as a target). HDClone will not restore a file
image that is password protected unless the correct password is specified. It is
also not possible to open or mount a password protected file image with » 8
Miray Virtual Disk without specifying the correct password first.

Password protection is a simple access protection for file im-
age. HDClone and Miray Virtual Disk will deny any access without the
correct password. For secure protection of the file image data, choose
the Data Encryption option ( » 5.7.5.1 File image as a target).

If you select the Data Encryption option when creating a file image (» 5.7.5.1
File image as a target) , the data in the image will be encrypted. HDClone uses
a 128 bit AES encryption for this purpose. The image data then cannot be read
without the specified password, neither with HDClone or » 8 Miray Virtual Disk
not with other software tools.

Since the data encryption used in HDClone is a secure meth-
od without a displacement password, image data created with encryp-
tion will be definitely irrecoverable if the password gets lost.

Currently, encrypted file images cannot be opened and mount-
ed as virtual drives with Miray Virtual Disk.

Encryption will usually increase the time required for creating and
restoring file images significantly. Select Data Encryption only if it is re-
quired. Otherwise the password protection mechanism may also be suf-
ficient and it will not increase the duration of the process.

HDClone cannot store file images directly on CD/DVD, but read file images from
there for restoring. Insert the CD/DVD into the drive before starting HDClone or
when the first screen appears. Choose Image-to-Drive or Image-to-Partition
mode and click on [Next]. When selecting the source image, the CD/DVD drive
will appear in the list and you can choose a source images from there.

When writing an HDClone image to CD or DVD it is required to
use an ISO file system. Please consider the manual of your CD writing
software in this case. The CD/DVD media has to contain the entire im-
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age. So called ,spanning’ of the file image is not supported by HDClone
But you can choose a file block size, matching the capacity of the target
medium optimally ( » 5.8.7 Options for source and target).

6.8 Defragmentation

HDClone can perform a defragmentation for
NTFS and FAT file systems during copying. On
the Options dialog page ( » 5.8 Selecting the
options), select Defragmentation ( » fig. 39). fig. 39: Defragmentation
Apart from the general advantages of a de-

fragmentation, in particular the acceleration of file accesses and the boot pro-
cess, HDClone offers the special advantage of performing the defragmentation
process with only little additional time required. Downsizing or defragmenting
can also be selected when restoring from file images if it has been created using
the options Store downsizing info or Store defrag info ( » 5.8.3 General options).

Important: Use defragmentation on healthy file systems only, meaning
©)

only those file systems declared being flawless by programs like chkdsk.
exe (under Windows).

This shifting aims to reduce the file system's size in as few steps as nec-
essary. For a real defragmentation select the option Defragmentation
explicitly even when downsizing a file system.

Note: When downsizing partitions, HDClone may also shift data blocks.

6.9 Command line interface

To use HDClone for automated processes or time-triggered calls, there is the ad-
ditional file hdclone-cl.bat for calling HDClone from the Windows command line.
This program is destined to be called by shell scripts or program links. It handles
user input and output exclusively via the command line and calling parameters.

This allows to use the command line version for areas of application, for which
the graphical version is not suitable, like the following examples:

o Time-triggered calling: Scheduled calls of HDClone by the Windows Task
Manager to start copying processes automatically, for example backups.

o Script integration: Calling HDClone from scripts for integrating it into auto-
mated processes, for example for mass installation (deployment).

o Programmed processes: For recurring copying processes, you can create links
in the Start Menu, the Quick Launch bar, or on the Desktop to allow these pro-
grammed processes to be called quickly and easily at any time.



When calling hdclone-cl -help or without any parameters, a list of
supported parameters in combination with a short description of their
usage will be displayed.

The following chapters list and explain the supported parameters. The order of
individual parameters when calling hdclone-cl is arbitrary.

To facilitate use of the command line version, it has its own Start Menu entry.
Under the HDClone entry, you find the sub-folder CLI. It contains two subitems:

o Opens a privileged Windows Shell in the program folder, so you
can directly start the command line version from here.

° Opens a folder with templates for batch scripts in the
Windows Explorer. You may customize them according to your needs.

Along the scripting templates, there is an hdclone-cl.bat file.
Use it instead of calling hdclone.exe cl, especially in complex scripts, to
ensure you obtain the correct result values ( » 6.9.7 Return values). Re-
place the call of hdclone-cl.exe from earlier versions with hdclone-cl.
bat.

The command line version of HDClone expects the following calling syntax:
o]
hdclone-cl -mode:d2d -srcdrv:[source] -dstdrv:[target]
hdclone-cl -mode:p2p -srcvol:[source] -dstvol:[target]
hdclone-cl -mode:d2i -srcdrv:[source] -dstvol:[target] -dstimg:[image]
hdclone-cl -mode:p2i -srcvol:[source] -dstvol:[target] -dstimg:[image]
hdclone-cl -mode:i2d -srcvol:[source] -srcimg:[image] -dstdrv:[target]
hdclone-cl -mode:i2p -srcvol:[source] -srcimg:[image] -dstvol:[target]

When using Enterprise Edition with more than one target, the
calling syntax is extended as follows: the parameter combinations



-dstdrv:[target], -dstvol:[target] or -dstvol:[target] -dstimg:[filename]
have to be specified iteratively, one for each copying target.

Providing the parameters described above is mandatory. If one of the parame-
ters is missing or has an invalid value, the call will be canceled with an error.

Drive-to-Partition and Partition-to-Drive modes are not available
in the command line version. Please use the functions for creating and
restoring file images instead.

To allow more areas of use for physical drives (-srcdrv:[sourcel/-dstdrv:[target]),
there are different ways to specify a drive:

° Physical drives are usually specified by their respective
ID, assigned by Windows at run-time. This ID is to be found in the Disk Man-
agement of Windows (diskmgmt.msc).

° You can also specify the port that is used to connect the drive
(not for USB and Firewire). If you specify the 2nd SATA port for the source, the
drive connected to it will be used, regardless of the Windows ID assigned to it.

° Alternatively, a drive can be selected by its
type name and /or serial number, regardless of the Windows ID assigned to it
or over which port it is connected. But it has to be unique in the context of the
copy to be created (and the Edition used).

You can use hdclone-cl -list to display a list of the available physi-
cal drives and their respective indications: Windows ID, port number,
and name/serial number.

In case there are several targets available under the identification provided,
HDClone Enterprise Edition will take this specification as unambiguous if the
number of drives is smaller than or equal to the maximal number of targets.

If you specify a drive name as target, which matches five
drives in the system. HDClone Enterprise Edition 8x will use all five
drives as targets, while the Enterprise Edition 4x will refuse cloning due
to the ambiguity.

If HDClone cannot make an unambiguous selection for the port
or identification specified, HDClone will abort the process with an error.



File images are specified as source or target ( » 6.9.2 Program call) using the
drive  name (-srcvol:[sourcel]/-dstvol:[target]) and the image name
(-srcimg:[image]/-dstimg:[image]). HDClone then creates or searches for imag-
es in the "HDClone Images” folder on the specified drive. A different folder can
optionally be specified with -srcdir:[path] or -dstdir:[path].

File images can also be created directly on network shares or be recovered from
there. Just use -srcvol:[source]/-dstvol:[target] to specify a path for the network
share instead of a drive letter. The network path must have the form:

\\[domain|computer]\[share]

For example “\\MyComputer\sharedfolder”. Subfolders on network shares can
be optionally specified using -srcdir:[path] or -dstdir:[path] (» 6.9.4 Folder
paths). Otherwise the default folder “\\MyComputer\sharedfolder” will be used
for network shares, too.

There is a number of further, optional parameters, allowing you to enable or dis-
able certain features of HDClone for the copying process. They are provided in
the form

-[option]:[on|off].

The following table lists the available options. The values printed in capital letters
(ON or OFF) represents the default value for the respective parameter. This val-
ue will be used if you do not explicitly provide this parameter. The individual op-
tions correspond to the options of the graphical HDClone program.

Option Meaning
-verify:[on|OFF] Perform an additional verification ( » 5.8.1 Verifying).
-smart:[ONJ|off] Faster copies by using logical file system information

(» 6.1.2 SmartCopy).
-freespace:[on|OFF] Copy unused areas ( » 5.8.3 General options).

-swapfiles:[on|OFF] Copy pagefile.sys and hiberfil.sys ( » 5.8.8 Advanced
options).



Option

Meaning

-defrag:[on|OFF]

-imagetype:
[full|[SMART |raw|
vmdk|vhd]

-timestamp:[ON|off]

-compression:
[on|OFF|quick|strong]

-resizeinfo:[ON|off]

-password:<password>

-encrypt
-maxsize:<size>

-skip:[pnrl:[pnr]...

-resize
-resize:<size>
-resize:fixed
-resize:skip
-resize:AUTO

-resize:[p11:[p21:[p3]...

-adjust:[ON|off]
-preferlock

-allowlock

-allowlazy

Also perform a defragmentation when
copying or store defragmentation information when
creating a file image ( » 5.8.3 General options).

Image type to be created, according to the available
image formats ( » 6.7 File images).

Automatically extends the names of image files by a
time-stamp. For labeling periodic backups and to avoid
identical naming of file images. Without this option,
the command line version will cancel the process in
case of identical names.

Create a compressed image, on for standard compres-
sion, quick for QuickCompress, and strong for Strong-
Compress ( » 6.7.6 Compressed Images).

Store information for downsizing
when creating file images ( » 5.8.5 Backup options).
Specify a password to protect the file image.

Encrypt image (only in combination with -password).
Limit the size of files in the image folder to a maxi-
mum. Value for size plus K/M/G/T for magnitude, for
example 650M, 4G, default is 2GC.

Numbers of the parti-
tions to be excluded from the copy or not stored if an
image is created. Numbering starts with 1, the parti-
tion order equals the order listed by the command
hdclone-cl -list.

Resizing partitions automatically or manually when
copying or restoring from a file image ( » 5.9.2 Adjust-
ing partitions), excluding individual partitions ( » 6.6
PartitionSelect). <size> = value for size plus K/M/G/T
for magnitude, for example 650M, 4G, default is 2G.
Automatic adjustment of disk parameters.

Reserve source for exclusive access, otherwise VSS

(» 2.9 HotCopy & Livelmage) will be used.

Only use exclusive source access if VSS ( » 2.9 HotCo-
py & Livelmage) is not available.

Use unsecured drive access, if exclusive access or VSS
are both not available.



Option Meaning

-report:[drvietter] Generate a report and store it to the specified drive
(» 6.10 Store final report).
-list Lists all drives and partitions recognized as well as their

internal numbering, port number, name, and serial
number ( » 6.9.3 Drive identification).

The command line version (CLI) of HDClone returns result values in the environ-
ment variable ERRORLEVEL. This allows to evaluate and to react to the copying
result automatically, for example by using batch files.

Option Meaning

0 Copying process finished successfully with no errors of
any kind or the program was called using parameters
-help or -list.

1 Errors in call (missing/duplicate/invalid parameters).

2 Invalid license or license expired.

3 At least one ‘resize’ parameter ( » 6.9.6 Optional pa-

rameters) is invalid, does not match the target size or
contains invalid characters.

Could not access source or target properly, for exam-
ple device or file image not found/access denied.

Password not specified or invalid password.

User abort (' Ctrl + C ).

Copying finished with verification errors.

Copying finished with read/write errors (overrides 7).

Some other error occurred. A specific error code, is
displayed with the console output of HDClone.
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In case of copying or restoring, you can use the resize option ( » 6.9.6 Optional
parameters) to specify how to adjust the sizes of individual partitions on the tar-
get medium. The resize option without any further parameters will cause all par-
titions to be resized proportionally to their original size. You can specify one or
more additional parameters to specify the resizing for individual partitions in their
natural order on the medium. These parameters are:

Increases or reduces the size of a partition to the size value specified.



The values may be specified in sectors (S), bytes (B), kilobytes (K), megabytes
(M), gigabytes (G), or terabytes (T). The desired numeric value has to be spec-
ified, immediately followed (without spaces) by one of the unit specifiers
above (for example: 10G = 10 gigabytes or 500M = 500 megabytes).

Keeps the partition size without any changes
Skips the partition, meaning it will not be copied ( » 6.6 PartitionSelect).

Adjusts the partition size automatically and proportionally to its share of
the entire medium.

The parameters for resizing (<size>, fixed, skip, auto) may be specified repeat-
edly, separated by a colon. The parameters will be applied to the partitions in the
specified order. In case there are more partitions than parameters specified, the
default parameter auto will be applied to the remaining partitions. If there are
more parameters specified than partitions available, the remaining parameters
are ignored. This option works equivalent to » 5.9.2 Adjusting partitions.

There are four partitions on the drive, but only two resize-
parameters are specified. The first two partitions will be adjusted as
specified. The two remaining partitions will be resized automatically, just
as if the parameter auto was specified for them.

The following examples represent a selection of frequently used scenarios, but
they do not cover all possible variations or areas of use.

’ hdclone-cl -mode:d2d -srcdrv:1 -dstdrv:2 -smart:off -freespace:on
hdclone-cl -mode:d2i -srcdrv:1 -dstvol:E -dstimg:backup
hdclone-cl -mode:i2d -srcvol:E -srcimg:backup -dstdrv:1
hdclone-cl -mode:d2d -srcdrv:1 -dstdrv:2 -resize
hdclone-cl -mode:d2d -srcdrv:1 -dstdrv:2 -resize:fixed

hdclone-cl -mode:d2d -srcdrv:1 -dstdrv:2 -resize:fixed: 100G

hdclone-cl -mode:d2d -srcdrv:1 -dstdrv:2 -resize:auto:fixed:fixed:fixed
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Hint: Call hdclone-cl -list to find out, which drive numbers are assigned

to which physical drives. You will be displayed a list of the available
physical drives in the system.

o Note: These and further examples are to be found in the CLI subfolder

of the program path after installing HDClone, or via [Start] » [Programs]

» [HDClone...] » [CLI] » [Sample scripts].

6.10 Store final report

After the process has been finished, you can generate and store a detailed final
report in a text file to document and analyze cloning processes. The report con-
tains the following Information:

o Program and license

o Device data (CPU, memory, etc.)

o Copying mode

o Source and target(s) including device details
o Option settings

o Duration and result including errors
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7 Troubleshooting

This paragraph describes possible problems when using HDClone and offers pro-
posals for solution. If there should be no proposal for solution for a problem, you
can gladly contact our » 9.5 Support.

7.1 Load errors

During the start of the program, before HDClone is loaded itself, a message and
a progress bar will appear on the boot screen. In case of an error, one of the fol-
lowing error codes will be indicated here.

7.1.1 Error #5002 and ‘Disk error’

This error will be displayed if the boot medium is not readable when booting the
program. The error is reported by the BIOS of the computer and points to a de-
fective data carrier or a problem with the used boot drive. In many cases, in par-
ticular when booting from a floppy disk, an incompatibility between drive and
data carrier is the cause. Principally this problem can be fixed. Please try the fol-
lowing steps, at best in the indicated order:

o Try again to boot the program, perhaps with/without cold start.
o Create once again a bootable disk ( » 4 Installation).

o Floppy disk: format the Floppy disk (no quick format) before creating a new
one.

o Floppy disk: Use another floppy disk.
o Use (if possible) another boot drive.
o Note: If you didn’t receive HDClone as an installation package but on a
Tl bootable disk and if a disk shows this problems also after multiple trials
on different devices, please contact our » 9.5 Support and indicate
your license number.

7.1.2 Other errors

If other errors in the form of # (number) should occur when loading the program,
please contact our » 9.5 Support.



HDClone supports keyboards and mice with PS/2 standard or USB connector
(» 3 Supported hardware). This also includes many wireless mice, given they are
connected as a true USB device. Input devices connected with Bluetooth are
currently not supported. In this case, please connect a separate USB device. If
keyboard or mouse (or both) do not function with HDClone, this is usually due
to a wrong legacy emulation setting in BIOS setup. On most computers, you can
fix this problem by changing (activating or deactivating, depending on the cur-
rent setting) the emulation for PS/2 devices in BIOS setup. Please consult your
computer manual on how to change this setting since it may be named differ-
ently according to the respective BIOS. In most of the cases, you can find it un-
der the name USB Legacy Support or USB Keyboard Support (often under Inte-
grated Peripherals or Advanced Options).

In some of the cases, problems with PS/2 keyboards or mice oc-
cur with active emulation for PS/2 devices. If you don't use any USB de-
vices, please switch off PS/2 emulation in the BIOS setup.

If you think the speed of the total system or the copying speed - also with IDE
and SCSI devices - is too slow, a USB controller can be the cause, even if it is not
used ( » 7.6.4 Speed loss).

In case the working speed of a copy is significantly below the
source medium and the technical performance data of the target me-
dium imply a significantly higher performance, the target medium might
be a drive with a deviant internal block size. In this case, try to use the
automatic alignment option ( » 5.8.7 Options for source and target).

When HDClone reports errors, this usually means defective areas on the medi-
um. General hardware problems can also cause read and write errors, usually
indicated by a very high number of errors. Try to fix the problem using the trou-
bleshooting instructions for the hardware type (IDE, SCSI, USB). If the problems
cannot be fixed this way, deactivate, step by step, the following options:

o CachedMemory

o Read cache and write cache



o FastCopy
o DMA
o SharedMemory

If the problem does not occur any more after having deactivated a certain op-
tion, the previously deactivated options can be reactivated as a test.

If HDClone does not recognize a hard disk, there can be several reasons. Perhaps
the controller, which the disk is connected to, has not been found (» 7.4.2 IDE
controller not found). A further possible reason can be a non-standardly con-
nected hard disk. This is for example the case if a hard disk is configured as slave
and if a CD/DVD drive or no drive at all is connected at the same IDE channel as
master. Normally, HDClone can handle that, too.

If an SATA hard disk is not recognized, this can also be due to the
used SATA controller ( » 3.3.2 SATA/SATA-II controllers).

There are the following three reasons why HDClone has not automatically rec-
ognized an IDE controller:

o The IDE controller/channel is deactivated, e.g. on an onboard IDE controller.
Activate the IDE controller/channel via the BIOS setup.

o Standard IDE controllers (ISA) are not taken into account if PCI IDE controllers
are available. Connect the respective hard disk to a PCl IDE controller in this
case or deactivate the PCI IDE controller or controllers.

o The used controller does not correspond to the PCI IDE standard. Although
most controllers support this standardized programming interface, there are
some controllers which have only a proprietary programming interface. More
detailed information can be found in » 3.3.1 IDE/ATA controllers. Connect the
corresponding drives to another controller (PCI IDE controller).

The following principal problems can occur with (Ultra) DMA:

o The achieved speed is too slow despite DMA. Please consider that the achiev-



able speed (» 3.3.5 Speed) depends on many factors and that this is not ab-
solutely due to a problem with DMA.

o DMA mode is not available. When selecting the options ( » 5.8.7 Options for
source and target), the option DMA is deactivated and locked in this case.

o Read, write or verification errors occur when using DMA.

In all cases, the problems can be due to the same reasons. When having prob-
lems with DMA, you can principally use PIO mode at any time. Deactivate the
option DMA of the concerned drive when selecting the options ( » 5.8.7 Op-
tions for source and target). Since PIO mode is usually much slower than DMA,
we recommend to try first of all the following hints and help instructions to pos-
sibly be able to use the DMA mode. Please consider the notes in the subchapter
» 7.4.4 BIOS settings.

o Check if the concerned drive really supports DMA. Some older drives and es-
pecially older CompactFlash media do not support DMA.

o Make sure that from Ultra DMA Mode 3 on an 80-wire data cable is used to
connect the drive(s).

o If two drives are connected via the same cable, the DMA mode of the slower
drive is also used for the faster drive. Remove the slower drive temporarily, if
possible, or connect the drives via separate channels or cables.

o Try both connections of the data cable (center connection and connection at
the end) in case of a single connected drive to eliminate possible problems
with damping (center connection) and reflection (connection at the end).

o Switch the used UltraDMA mode to a lower value in the BIOS setup ( » 7.4.4.1
Switch to a lower/higher UltraDMA mode) or deactivate UltraDMA (» 7.4.4.2
Activate/deactivate UltraDMA). Multiword DMA mode will be (automatically)
still available, which offers about a twice to four times higher speed than PIO
mode.

o On the other hand, you can also try to activate UltraDMA or to switch to a
higher UltraDMA mode if the corresponding default settings in your BIOS set-
up are too low.

Our tests revealed that some chipsets and hard disks do not col-
laborate optimally. This can lead to UltraDMA mode (putatively cor-
rectly) recognized and set in the BIOS is too high.

In case of problems when using DMA, please refer to the following notes



The following notes refer to settings which you should possibly make in the BIOS
setup of your computer if problems occur during the use of DMA. Since the set-
tings in the BIOS setup are manufacturer- and model-specific, these notes can
only be given in a general form. Refer to your BIOS manual on how exactly to
make these settings and which settings are available at all. You usually find the
DMA settings under Integrated Peripherals or Chipset Setup in the BIOS setup.

Please perform automatic hard disk recognition in BIOS after each
modification of the DMA and hard disk settings so that the modifica-
tions for the corresponding drives become effective. Make sure to save
the modifications via Save and Exit when leaving BIOS setup.

In many BIOS setups the (highest) used UltraDMA mode can be selected manu-
ally. If you have problems with DMA, try to switch the used mode step by step
to a lower level at the corresponding IDE channel. Only if this does not solve the
problem, deactivate UltraDMA completely. The controller then mostly (auto-
matically) uses multi-word DMA, which is at least faster than PIO. You can switch
the UltraDMA mode step by step to a higher level, if you think you have not se-
lected the best possible UltraDMA mode.

Some BIOS setups do not offer a free selection of the UltraDMA mode but only
an automatic recognition or deactivation. If this is the case with your BIOS or if
you have already switched to the lowest UltraDMA mode and problems keep
occurring, deactivate UltraDMA. Usually, multi-word DMA is (automatically)
available then, which is often faster than PIO. Only if this doesn't function either,
you should completely switch off the DMA mode in HDClone ( » 5.8.7 Options
for source and target). If UltraDMA is deactivated in your BIOS setup, you can
activate it as a test, of course, in order to attain a higher speed, if possible.

If there are problems in the PIO mode as well, you should deactivate 10 caches
and buffers. In particular the setting Dataport Postwrite, if available, should be
switched to Disable if there are problems.

If HDClone should not work as desired despite all the above mentioned instruc-



tions, you can try to set standard values via the option Load BIOS/Setup De-
faults. This setting tries to avoid possible hardware conflicts.

When using SCSI devices, please make sure that they are correctly configured
and connected to the SCSI controller. In particular SCSI controllers with SCSI BIOS
must show a hard disk during the system start, so that HDClone can then address
this hard disk. Furthermore, HDClone must support the controller you use. You
find a list of the supported SCSI controllers in chapter » 3.4.2 Compatibility.

Even if an SCSI controller shows the desired drives during the sys-
tem start, this is no guarantee that they are correctly configured or con-
nected. In principle, the BIOS of the SCSI controller works on a lower
level than the SCSI drivers used by HDClone and can thus possibly rec-
ognize hard disk drives which are not recognized by HDClone itself.

HDClone has been tested on a range of SCSI controllers. Sporadically encoun-
tered problems are bypassed by the software as far as possible. The following
subchapters contain useful hints on how to solve further random or sporadic
problems. These hints should be applied in the described order to minimize the
effort, if possible. The following problems occurred during the tests and could be
bypassed with the hints from the following subchapters:

o HDClone stops during device recognition ( » 5.6 Selecting a copy mode)
o No SCSI hard disks are recognized
o Not all SCSI hard disks are recognized

If HDClone stops during the startup or does not show the desired SCSI drives, try
to restart with @ warm boot (reset button). Only if this does not fix the problem,
you should try a cold start (switch off the PC and switch it on again after 30 sec-
onds). Both forms of restart may solve signal problems of SCSI controllers.

If a restart does not lead to the desired result, you should, if your system dispos-
es of several SCSI controllers, deactivate unused controllers. This is also recom-
mended if a controller is principally used, but the hard disks connected to it are
not needed for using HDClone.



In some cases, SCSI hard disks, which are connected to the same controller, can
interfere with each other or even with the controller itself. Deactivate individual
hard disks as a test or connect them step by step after one another to find out
which hard disk possibly causes an interference. Make sure that the last SCSI de-
vice is always terminated also during the tests.

The configuration of the SCSI controller over its BIOS setup or the BIOS setup of
the PC, in case of onboard controllers, can also solve the problem. Set the lowest
resp. the securest values for the SCSI bus (e.g. transmission in the narrow mode
of a wide controller).

Try to connect the SCSI hard disks used in the system in a different way, espe-
cially if you use several SCSI controllers. Proceed as follows, if possible: deacti-
vate all SCSI controllers except one. This controller should have one SCSI chan-
nel only, if possible, and be part of the controllers listed in » 3.4.3 Manufacturer
information. Connect then the needed drive or drives only. Apart from defective
drives, this strategy mostly allowed us to find a functioning configuration during
our tests to execute the planned job.

Despite the vast support of USB controllers and storage devices (» 3.5 USB),
there are some cases where these controllers and devices do not function as
expected. The following subchapters provide you with hints and solutions.

Mostly, there are four possible reasons why a USB storage device supported by
HDClone ( » 3.1 Overview) is not recognized:

o The USB storage device has been connected too late or exchanged after-
wards. USB storage devices should be connected to the computer before
starting HDClone ( » 5.1 Preliminary steps).

o The USB storage device is not directly connected to the USB controller but via
a hub (e.g. at the monitor). Always connect the USB devices, you wish to use
with HDClone, directly to the USB controller or to the computer.

o The used device is no standard-conform USB mass storage device and does



there-fore not belong to the supported devices ( » 3.5.1 Mass-Storage-Class).

o The USB storage device is defective or works faultily. You should then test its
functionality by using it with another PC or another operating system.

If no USB storage device is recognized and if the above men-
tioned possibilities are excluded, the corresponding USB controller has
probably not been recognized ( » 7.6.3 Controller not found).

Some devices, especially USB sticks, can show malfunctions in case of tempera-
ture rise or continuous operation, i.e. in case of continuous reading or writing big
amounts of data. With HDClone, these problems manifest in read or write errors
on the respective USB storage device, which do not always occur at the same
location but after a certain operating time. Sometimes these hardware problems
also lead to very long breaks during the copying process, which can be up to
several minutes. When selecting the options ( » 5.8.3 General options) , try to
deactivate the option FastCopy in this case. Only if the problem persists, activate
additionally the option Cooling off break for the concerned device. Thus, the
copying process takes a bit longer, but usually the data transfer works better.

The described problems are mostly due to deficient hardware
and also occur under other operating systems. We recommend you to
have the concerned device replaced by your vendor.

HDClone should recognize all current USB controllers which offer one of the USB
standard interfaces ( » 3.5.2 UHCI, OHCI and EHCI). If HDClone recognizes USB
devices on one PC but not on another PC or on another controller, the USB con-
troller can have one of the following problem:

o The USB controller does not meet to the UHCI, OHCI or EHCI standard. In this
case, use another compatible ( » 3.5.2 UHCI, OHCI and EHCI) USB controller.

o The USB controller is deactivated, e.g. in case of an onboard USB controller.
Activate the USB controller via the BIOS setup.

o The USB controller does not function correctly or is defective. Use another
USB controller or another PC for the copying process.

USB controllers can have a negative effect on the speed of the whole system.
This particularly affects the copying speed of all device types (also IDE and SCSI),



even if no USB storage device is connected. Remove the corresponding USB
controller if it is not needed during the use of HDClone. Otherwise, there a no
negative effects apart from the speed loss.

In our tests, this problem showed up with only one USB controller
(VIAVT6212) and also persisted on other computers and operating sys-
tems with this controller. The measured speed loss on the PCI bus was
at about 40% (1).

Another problem is an incompatibility with certain USB storage devices caused
by the USB controller. Especially older USB devices do not function flawlessly in
such USB controllers. Use another USB controller, if possible.

In our tests, this problem showed up with only one USB controller
(Acer ALi M5273) and was also reproducible on other computers and
operating systems.

When using mapped drives in Windows, HDClone may not find the mapped
drives in some cases, since HDClone is running in administrator mode. To use the
established mapped drives, a small change to the Windows Registry is required.
Usually, » 4.2.1 HDClone Setup will handle this automatically. But you can also
make the change manually, as described below:

o Open the registry editor (regedit.exe)

o Move to the following registry key in the tree structure
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Policies\System

o Create the DWORD value EnableLinkedConnections

o Set its value data to 1 and restart your computer

To undo the changes, simply delete the registry value.
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8 Miray Virtual Disk

HDClone contain the software Miray Virtual Disk, which allows to mount file im-
ages created with HDClone - even VMDK and VHD images - as virtual drives
under Windows. You then can access files and folders stored within a file image
directly. Miray Virtual Disk can be started on demand or automatically at system
start-up. File images may be mounted either just on demand or persistently.

o Note: You can also open and mount file images as virtual drives directly,
Tl from the network, using network drives or network shares.

8.1 Installation

Miray Virtual Disk is included with the » 4.2.1 HDClone Setup. During setup, you
can choose to install » 4.1.3 Miray Virtual Disk. It will be installed to a separate
location in the Program Files directory.

8.2 Program startup

You find Miray Virtual Disk in the Windows Start menu in the HDClone folder. At
startup, the program window will appear ( » fig. 40). Since Miray Virtual Disk
works in the background, the program icon will appear in the System Tray. Miray
Virtual Disk will remain active in the background, even if you close the program
window. You can open the program window again using the System Tray icon.

8.2.1 Program window

Use the program window (> fig. 40), (B ==
to open file images and create virtual e —
drives. It contains three major ele-
ments: menu bar, » 8.2.2 Image list,
and control buttons at the bottom.
You may also control Miray Virtual
Disk using the Context Menu (right
click on the image list) or keyboard
shortcuts (hotkeys) ( » 8.3 Operation).
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You can use the control buttons to
add an Image ([Add..], see »8.3.1

fig. 40: Program window
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Adding an image) to or to remove an Image ([Remove], see » 8.3.2 Removing
an image) from the image list. Press [OK] to close the program window. Miray
Virtual Disk will though stay active in the background ( » 8.2.3 Tray icon).

o Note: Adding an image to the image list does not automatically create
7L | a virtual drive. The image list shows the partitions an image contains, so

you can mount them separately ( » 8.3.4 Mounting an image).
Hint: If you have several images in the list, you may want to resize the
@ program window freely by clicking and dragging the lower right corner.
<

8.2.2 Image list

The image list serves to manage the images added before and offers an over-
view of the partitions they may contain. Partitions are always displayed right be-
low the image they belong to. To distinguish the individual entries in the image
list, there are different symbols as listed below:

File image
Image is not mounted

File image
Image could not be found

- File image
File image .
. Image is mounted perma-
Image is mounted
nently
SuperFloppy (no MBR) Partition

Volume is not mounted Partition is not mounted

Partition
Partition is mounted

SuperFloppy (no MBR)
Volume is mounted

DOOD I
% @B

SuperFloppy (no MBR) Partition
Volume is mounted perma- Partition is mounted perma-
nently nently

Note: In addition to the symbols listed above, there is a column Status,
where a mounted image or volume will be marked with letter M or - if
permanently mounted - with MP.

|



You can directly open mounted partitions in Windows Explorer by
double-clicking in the File image column. This may be especially useful,
if there is no drive letter available to be assigned to the partition.

You can see whether Miray Virtual
Disk is active or not from the program
icon appearing in the System Tray
(Tray icon). You can open the program
window by double-clicking the Tray
icon. Right-clicking the Tray icon opens fig. 41: Tray icon and context menu
the context menu (»fig. 41) which

gives you direct access to the following four functions:

Autostart

Add image...
Show program window.
Quit Miray Virtual Disk

= (&l ]

o [Autostart]: Same functions as » 8.3.7 Autostart.
o [Add image]: Same functions as » 8.3.1 Adding an image.
o [Open program window]: Opens the program window or brings it to the front.
o [Quit Miray Virtual Disk]: Same functions as » 8.3.9 Quit program.
If you want to open the program window, double-click the Tray

icon. If the Tray icon is not visible, Miray Virtual Disk is not active and
there are no virtual drives available.

You can operate Miray Virtual Disk using the menu bar on the top of the win-
dow, the control buttons on the bottom of the window or the context menu
(» 8.2.1 Program window).The context menu opens by right-clicking on entries
or on the free area of the image list. You open the tray context menu by a right-
click on the program icon in the System Tray.

At first, you can add a file image to the image list of the program window. There
are five ways to achieve this:

o Control button [Add...]
o Menu bar [File] » [Add image...]
o Context menu [Add image...]

o Tray context menu [Add image...]



o Hotkey ' F2

o Drag-and-drop from any Explorer window

The image list also displays information on the partitions and file systems of each
file image in the list ( » fig. 40).

Depending on the version of the program, you will be allowed to
add one or more images. When you quit the program, Miray Virtual
Disk will memorize these images for the next program startup.

Select one or more file images, you want to remove from the image list. There
are four ways to remove them:

o Control button [Remove]
o Menu bar [File] » [Remove image]
o Context menu [Remove image]

o Hotkey ' Shift + F2

If images or individual partitions you want to remove are still
mounted as virtual drives, the file image cannot be removed. A corre-
sponding message will appear.

There are three ways to remove all images from the image list:
o Menu bar [File] » [Empty image list]

o Context menu [Empty image list]

o Hotkey = Ctrl + Shift + F2

If one or more file images to be removed from the image list (or
individual partitions thereof) are still mounted as virtual drives, the im-
age list cannot be emptied.

You can mount previously added file images or individual data areas (volumes)
as Windows drives. When mounting an image, it will be made available as a Win-
dows disk and will behave just like a physical disk. When mounting an entire file
image which contains several partitions, you obtain several drive letters, one for
each partition containing a file system Windows is able to access. When mount-



ing an individual partition, you may obtain one drive letter for this partition if
Windows supports the file system it contains.

There are three ways to mount an entire file image or an individual partition. Se-
lect one or more images or partitions first:

o Menu bar [Image] » [Mount]
o Context menu [Mount image]

o Hotkey F8

As soon as an image or a partition has been mounted successfully, this will be
displayed in the image list as follows:

o The icon of the image or partition mounted will be displayed in color.
o The capital M is displayed in the column next to the icon.

o The drive letter(s) assigned to the virtual drives will be displayed in the row of
the mounted image or partition.

The capital M always appears in the row of the object which has
actually been mounted. For example, mounting an image containing
two partitions, M will appear in the row of the image. If mounting both
partitions individually, the capital M appears in both partition rows.

You can make mounted virtual drives persistent. This means that these virtual
drivers will be mounted automatically with any start of Miray Virtual Disk. They
will remain mounted as long as the program is active. In case this feature is used
in combination with the option » 8.3.7 Autostart, the respective virtual drives
will be available at any time while Windows is running.

Password protected images cannot be mounted permanently,
since the password would have to be stored. This would compromise
password security and therefor is not supported.

If you want to mount images or partitions thereof permanently, there are three
ways to achieve this. Select one or more images or partitions first:

o Menu bar [Image] » [Mount permanently]

o Context menu [Mount image permanently] / [Mount volume permanently]
(right-click on the desired image or partition in the image list)

o Hotkey  Ctrl + F8

Persistent mounting can be applied to mounted and unmounted images or parti-



tions. As soon as an image or a partition has been successfully mounted persis-
tently, this will be displayed in the image list as follows:

o A mall green point @ appears in the icon of the mounted image/partition.

o The capitals MP are displayed in the column next to the icon

To cancel persistent mounting, mount the regarding image or
partition normally (» 8.3.4 Mounting an image) or unmount it com-
pletely ( » 8.3.6 Drive unmounting).

There are three ways mounted images and partitions and the regarding virtual
drives can be unmounted. Select one or more images or partitions first:

o Menu bar [Image] » [Unmount]
o Context menu [Unmount image] / [Unmount volume]

o Hotkey Shift + F8

As soon as an image or an individual partition have been unmounted, the re-
spective icon in the image list will be displayed in gray and the capitals M or MP
in the column next to the icon as well as the related drive letters will disappear.

You can select to start Miray Virtual Disk automatically at system startup (Auto-
start). This allows to have persistently mounted drives permanently available
without having to start Miray Virtual Disk manually.

There are two ways to switch the Autostart function on or off:
o Menu bar [Image] » [Autostart]
o Tray context menu [Autostart]

The menu item indicates whether the Autostart function is currently active. If the
menu item [Autostart] is displayed with a leading check mark, the Autostart
function is already activated. Without a check mark, the Autostart function is not
active.

If Miray Virtual Disk is started automatically at system startup,
only the » 8.2.3 Tray icon will appear. Double-click it to open the pro-
gram window.



You can close the program window at any time. Miray Virtual Disk will though
stay active in the background. There are two ways to close the window:

o Menu bar [File] » [Close window]

o Hotkey  Ctrl + W

To quit Miray Virtual Disk completely, there are three ways:
o Menu bar [File] » [Quit Miray Virtual Disk]

o Tray context menu [Quit Miray Virtual Disk]

o Hotkey Ctrl + Q

When quitting Miray Virtual Disk, all active virtual drives will be
unmounted, after a corresponding dialog has been confirmed. They will
be unavailable until next program startup.

If there are no drive letters or less drive letters than partitions displayed after
mounting an image, there may be several reasons:

o Windows drive recognition of one or more virtual drives has been delayed. In
this case, they have a drive letter assigned, but Miray Virtual Disk does not
display it yet. Press the = F5  key or select [Image] » [Refresh list] from the
main menu to update the image list.

o One or more partitions contain file systems Windows is unable to use (e.g.
Linux file systems). In this case, the behavior is normal, since Windows is not
able to use these file systems.

o There are no more Windows drive letters available. Windows recognizes the
mounted partitions, but cannot assign drive letters to them. In this case, free
one or more of the drive letters currently in use.

o If there is a drive letter displayed, but the drive has no content or Windows
prompts to format that drive, the file system is damaged. The image may have
been created from an inconsistent or damaged file system.

There are three different ways to mount file images in Miray Virtual Disk:



o Menu bar [Image] » [Advanced] » [Mount (R/O)]
o Menu bar [Image] » [Mount]
o Menu bar [Image] » [Advanced] » [Mount (R/W)]

In this mode, virtual drives can only be read. In previous versions of Miray Vir-
tual Disk, this was the only mode available. In this mode, no changes are made
to the mounted images and no changes can be made to the file system on the
virtual drive. For example, it is not possible to change file names or access rights
in this mode.

This mode is the default mode when mounting file images. It allows to read from
and write to file images. The data written will be stored separately in this mode.
This means that the data of the original file image remains unaltered, even when
writing to the virtual drive. To make changes available in the original image, some
Editions of HDClone allow to create a new image of the desired type from the
virtual drive ( » 8.7 Copy to other Image formats)

This mode works with any kind of file image. For high performant
access, it is recommended to use RAW images ( » 8.6 Converting to
RAW image) in R/W mode ( » 8.5.3 Direct read/write access).

To undo changes to an original image, resulting from write access to it, select the
image in the list and unmount it. Then click on [Extras] » [Delete overlay data].
The file image then has been reverted to its original state. Any changes made to
the virtual drive are then made undone.

To delete overlay data created with Miray Virtual Disk 3.x and ear-
lier, double-click the file image in Windows Explorer and delete any files
with the .ovl extension there.

In this mode Miray Virtual Disk writes or reads directly from a RAW image. It of-
fers the fastest possible access - comparable to physical media access. This
mode will immediately and irrevocably change the RAW image - in contrast to
normal read/write access ( » 8.5.2 Read/write access (default)). Therefore you
may consider creating a copy of the original RAW image before using direct
read/write access.
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o Note: This mode can only be applied to RAW images. If required, you
71 | can convert other image types into RAW images ( » 8.6 Converting to

RAW image).

8.6 Converting to RAW image

One main advantage of Smartimages is the strongly reduced size they require
for storing. When using Miray Virtual Disk, RAW images offer a clearly higher ac-
cess performance of the virtual drive. If required, you can convert a Smartimage
to a RAW image via [Extra] » [Create RAM image...].

8.7 Copy to other Image formats

Use HDClone to create a copy of a virtual drive into a new image of any format
required (Full, Smart, RAW, VMDK, VHD), independent of the original image for-
mat the virtual drive is based on.

Especially in cases where an image has been mounted with » 8.5.2 Read/write
access (default), the changes made on the virtual drive are not stored in the
original image. In this case, you can use such a copy to create a new image of
the desired type, which will then contain all changes made to the virtual drive.
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9 Miscellaneous

9.1 Terms of license

HDClone is designed to offer you the highest possible technical flexibility, and
also the HDClone license conditions are designed not to limit your flexibility
when using HDClone. Since you usually don't know at the beginning on how
many computers and how often you will use the software, we offer you a very
simple and cost-effective license model, which restricts you the least possible.

9.1.1 License model

The following table shows you the minimum number of licenses necessary for
the respective area of use.

Edition Private users ~ Companies/Institutions Professionals
Free Sufficient Insufficient Insufficient
Basic 1 license Insufficient Insufficient
Standard 1 license 1 license per location Insufficient
1 license per 5 PCs
Professional 1 license 1 license per location "
1 license per dedicated PC *
1 license per 25 PCs ? 1 license per techni-
cian ¥
Enterprise 1 license 1 license per location "
1 license per dedicated PC *
1 license per 100 PCs # | 1 license per techni-
cian ¥

" License is taken into account for the respective other indicated criteria.

) Existing PC work stations, regardless of actual use of HDClone.

? Technicians are all employees who use HDClone simultaneously or for field service.
4 PC which is exclusively used for HDClone, for example as copy server.

In practice, the use of HDClone can involve a different number of PCs accord-
ing to the area of use, despite a similar use. Either the program is permanently
used on one single or several few computers, which the media to be copied is
connected to when needed. Or HDClone is always used directly on the re-



spective computers, which the media to be copied is connected to; mostly
with only one usage per computer. To find a fair regulation for all use cases,
you can choose between a license per dedicated PC and a license for a lump
number of work station PCs where HDClone could be used. Furthermore, you
need additional licenses if you use HDClone (potentially) in parallel on several
PCs, for example if several service employees use HDClone independently
from each other. That is why you need at least one license per branch office
because this also represents a (potentially) parallel use.

The following examples refer to frequently occurring license situations:

o A company with 50 PC work stations needs two licenses of the Professional
Edition, whereof each covers 25 PC work stations.

o A company with 100 PC work stations needs four licenses of the Professional
Edition, one for 25 PCs each.

o A service provider with two PCs that serve as HDClone copy station needs
two licenses of the Professional Edition, one for each copy station.

o A service provider with two field service employees who use HDClone needs
two licenses of the Professional Edition, one for each independently working
technician.

A license is unlimited concerning the number of usages and the period of valid-
ity. It can be used as often as desired and without a time limit. However, the li-
cense is limited with regard to the (also potentially) parallel use on several com-
puters and the size of the company or the institution concerning the number of
existing PC work stations.

If you have questions concerning the license situation in your specific case,
please contact us at products@miray.de. We will be pleased to advise you on
volume licenses or more complex cases and offers you attractive discounts
make you an individual offer.

The following notes exclusively refer to the boxed versions of HDClone and not
to the versions available as download or via email.



For the protection against bootleg copies, our software is equipped with a secu-
rity hologram, among others. Each of the original data carriers you received
bears a security hologram. Please keep the data carriers with the security holo-
gram in any case because this is your license proof.

The condition to have a valid product license is that the number printed on the
security hologram corresponds to the number shown within the program. If this
should not be the case for your software package, please email us at products@
miray.de. Please indicate the number displayed by the program, the number on
the security hologram and where you acquired the software package. If there is
no security hologram on the data carriers or if the security hologram is damaged,
please contact us as well and indicate the above mentioned data. We will try to
find a simple solution so that you obtain a valid license.

Make sure that each data carrier you received bears its own se-
curity hologram with its own registration number and that this number
has to correspond to the number of the program which has been start-
ed from this data carrier. That means if you start the program from a
floppy disk, the displayed number has to correspond to the number of
the security hologram on the floppy disk and not to the number of the
security hologram on the CD.

Parts of this product are based on works licensed under the GNU General Public
License (GPL). The appropriate license is to be found at http://www.gnu.org/co-

pyleft/gpl.html. On request to support@miray.de we will send you a copy of the
source code.

Although HDClone was programmed with the largest possible caution and was
tested on a large scale of different systems, we hope you understand that we
cannot assume any liability for the proper functionality of the program and that
we are not liable for damages resulting from its usage, subject to gross negli-
gence and intention.
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9.4 Feedback

We are highly interested in your feedback. If you encounter any program errors
or if you have any improvement ideas, we will always try to fix the errors and
implement or integrate your ideas. If you only want to tell us your opinions on
this software, we are looking forward to receive such information from you.

Internet http://www.miray.de/
Email feedback@miray.de
Fax +49 (0)89 72013-647

Postal address Miray Software AG
Gaissacher Str. 18
81371 Munich
Germany

9.5 Support

If you encounter any problems with one of our products, our support team is
gladly at your disposal. Please send us your inquiry through our homepage at
http://www.miray.de/support/ or email us at support@miray.de. Please note that
inquiries sent directly per email and not over our homepage take a bit longer to
be answered due to the system.
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